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1 Welcome

1.1 Introduction

Welcome to PhonePad.

PhonePad is a Windows application that is designed to replace the "While You Were Out" telephone
message pads commonly found in offices around the world.  Quite often, when you answer someone's
phone, there is never a pen or piece of paper handy to take down the caller's details. And when there is,
it takes time to write down all of the particulars.

What about when someone has taken a phone message for you?  Have you ever had to try and decipher
the details on the message?  Have you ever had to try to work out what the phone number is only to find
out that it's a wrong number because the 1 looks like a 7 and you're not sure if that's an 8 or a 9.

Now there's an easier way - PhonePad.  With PhonePad, you can quickly take a message for someone
else with a little bit of typing and a few mouse clicks.  And if someone has called previously, PhonePad
will automatically fill in some of the details for you.
When you are away from your desk you don't have to return to a pile of telephone message slips spread
all over your desk or stuck all over your PC's monitor.  And it means you'll never lose an important
message!  

There's also the privacy aspect to consider.  Paper telephone messages can be read by anyone - you
may not want other people to see who has been calling you, what their phone numbers are, and what
the messages say.  PhonePad keeps all of your messages neatly together in its Inbox that can only be

accessed by you. 

PhonePad is ideal for Receptionists.  They can take messages for staff and send them to the particular
person's Inbox.  Receptionists can also check a user's Inbox.

And PhonePad doesn't need an email system to work.  It is totally independent of any messaging
systems.  This means that if the email system goes down, PhonePad continues to work.  It also means
you don't have to have an email system to use PhonePad.  All PhonePad needs is a drive that is shared
between users who want to be able to send phone messages to each other.

If you are a brand new PhonePad user, then there are lots of features for you to explore.  But don't worry,
you can use PhonePad as is, or customize it to your preferences.

If you have used previous versions of PhonePad, you will be pleasantly surprised with the new features
PhonePad now has.

In either case, we hope that PhonePad will be a valuable aid to your office and will improve productivity
and efficiency.

Cybercom Software
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1.2 Version History

Version 4.19 Fixed speed issues and errors on searches.
Fixed text printing errors.
Fixed missing message icons on search results.
Fixed issue with wrong follow up details being displayed when editing or viewing follow
up notes in personal folders.
Fixed issue with custom labels not being displayed in phone messages.
Added warning message when trial period or temporary license has 7 days or less to
go.
Added option for selecting the TAPI device.
Other minor fixes.

Version 4.18 Added option for automatically moving read messages to a personal folder.
Added option to Automatic Message Forwarding to only send Urgent messages.
Added option to the Forward By PhonePad feature (under Automatic Message
Forwarding) to not send Private messages.
Added option to set a default action when double-clicking on PhonePad system tray
icon.
Integrated custom message label editing into PhonePad Admin.  Removed separate
LabelEditor utility.
Changed Address Book so that only administrators can delete all entries.
Added option for disabling confirmation message when phone messages are canceled.
Added status report to PhonePad Admin that shows that status of all messages in each
user's Inbox.
Changed format of trace logs to XML.
Administrators can now view Private folders.
Fixed issue with Follow Up Notes list not clearing when selecting another folder.
Fixed issue with Forward By PhonePad feature (under Automatic Message Forwarding)
not working under some circumstances.
Fixed issue Caller Lookup entries not being deleted when the corresponding Address
Book entry is deleted.
Fixed Subject wrapping issue on some printouts.
Fixed SQL error that occurs when names contain apostrophes.
Fixed encrypted connection issues.
Fixed issue with DBRepair repair log.
Automatically updates local help files if required.
Other minor fixes.

Version 4.17 Added ability to email messages via SMTP.
Configurable authentication methods added.

Version 4.16 Added Caller ID.
Added received call logging.
Added automatic displaying of messages.
Added feature that allows follow up notes to be assigned to another message.
Email Message feature can now use SMTP mail server as well as MAPI.
Fixed issue with follow up notes being assigned to the wrong message.
Fixed issue with new messages sometimes not being displayed in Inbox.
Minor fixes.

Version 4.15 New Follow Up Notes feature allows multiple notes for each message.
New option for sorting message lists.
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When forwarding or replying to phone messages, messages now include text from
phone message.
Latest News menu option.
Updated message printing.
Added option for installing help files to local drive.
Speed improvements.
Fixed text overlapping problem during printing.
Fixed issues with moving messages between folders.

 Fixed issue with Sidebar icons not working.
Fixed error that occurs when archiving messages within PhonePad (not PhonePad
Admin).
Fixed problem with incremental search not working on caller lookup in new phone
messages.
Added an option to allow message follow ups to be marked as completed even if they're
not marked for follow up.
Minor fixes and improvements.

Version 4.14 PhonePad Admin can now import users in one batch via CSV or XML files.  This should
make it easier for networks with a lot of users.
New Reports - New statistics reports added to PhonePad Admin.
Added Refresh option to user list in Receptionist mode.
Added Quick Print option for printing messages in a compact format to save paper.
Fixed problem with message area default font not observing settings in Preferences.
Fixed problem with flash notification option continually flashing.
In Receptionist mode, the search option should search the selected user's Inbox - fixed.
Search not returning all results - bug in search code - fixed.
Fixed problem with PhonePad Admin starting with a blank user list when there was a
database connection error.
Fixed problem with user list in Receptionist mode showing blank entries.
Removed Logged In status from PhonePad Admin as it is not reliable.
Updated links in SupportCenter.

Version 4.13 Fixed problem with sorting in Address Book list where lower case names wouldn't sort
properly.
Fixed problem where double-clicking on the Address Book list wasn't opening an entry
for edit.
User passwords are now masked in PhonePad Admin and administrators are now
required to confirm passwords

Version 4.12 Enhanced and improved performance of caller lookup when creating phone messages.
Improved Address Book list, including sorting and incremental searching.
Improved archiving in PhonePad Admin
Changed In-Out Board to allow blank Back At times.
Added new option to Preferences that will scroll the Inbox to the most recent message.

Version 4.11 Added shortcuts for Address Book and In-Out Board to the system tray menu.
Added shortcut keys to message TimeStamp option.
AddressBook now remembers window size.
Fixed problem with "Message Sent" message.
Fixed problem "Table not in insert or edit mode" errors.
Minor fixes.

Version 4.10 Added option to customize color of messages in Inbox message list.
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Added ability to send multiple attachments to the Email Message feature.
Added quick phone and text message option to system tray menu.
Fixed problem with "expression" error in message printing
Fixed problem with Access Violations when two message are open simultaneously and
sent.

Version 4.09 Added attachment option to the Email Message feature. 
Improved performance of DBUpdate by removing repair and optimization 
Fixed Access Violation errors with message printing. 
Fixed network tuning parameters. 
Fixed problem with SMS message sending in MessageSender.
Fixed problem with customized labels in MessageSender.

Version 4.08 PhonePad now features Spell Checking, including Live Spelling and AutoCorrect.
Added various SMTP Options to MessageSender preferences.
Added extra MessageSender logging option.
Major upgrade to PhonePad's printing and reporting engine.
When the Subject is changed in a received message, the subject field is now
automatically updated in all Inboxes to match.
Caller details (Name and From) loading can be turned off.
Caller details loading multi-threaded to improve phone message load times.
Search function now supports searching archived messages.
PhonePad now remembers default print settings.
Fixed report in PhonePad.
Fixed report in PhonePad Admin.
Fixed Address Book importing problem.
Various minor fixes.

Version 4.07 The phone number lookup window has been improved to allow you to add all phone
numbers for new callers at the time of taking a phone message.
The new SupportCenter utility provides instant and convenient access to all support
resources available to you from one central location.  Just one click takes you to
whatever you need.
Added option to prevent messages from being sent if Subject field is blank.
Added option to disable mouse in Recipient List in phone and text messages.
Added user list refresh option to PhonePad Admin.
Added Log SMTP Responses option to MessageSender.
Added SMTP Email Formats to MessageSender.
Added ability to mark messages as Urgent after they have been received.
Added ability to lock Distribution Groups.
F6 key jumps to Subject field in phone and text messages.
Messages that were marked as completed were resetting back to follow up - FIXED.
Fixed reports in PhonePad Admin.
Various minor fixes.

Version 4.06 License keys now embedded into PhonePad database.
Added SMS Support for Automatic Message Forwarding..
Added Multiple Email Addresses for Message Forwarding.
SendAgent is now called MessageSender.  Numerous changes to user interface and
functionality.
Added message archiving to PhonePad application.
Added message broadcasting to PhonePad Admin.
Added Logout Users option to PhonePad Admin.



Welcome 5

Copyright © Cybercom Software

Added Server Announcement facility to DBServer and DBConnect.
Improved message searching.
Changed Caller Info feature to display all details for callers.
Updated License.exe to download license keys from license server.
Fixed problem with message count in Receptionist Mode.
In Receptionist Mode, all messages would be displayed for a user when PhonePad
starts up - FIXED.
When sending a phone message, it would prompt for which phone number to update,
even though this is set to automatic. - FIXED.
Multiple email addresses had broken Email Sending feature. - FIXED.
ALL button in Recipients selection window occasionally cause an error.  If the error
message is hidden, PhonePad appears to have frozen. - FIXED.
Various minor fixes.

Version 4.05 Message list report added to PhonePad Admin.  Also added ability to export report in
CSV format.
Popup caller phone window in phone messages has been improved and now allows
phone numbers to be edited.
New subject prefix option added.
Default subject when no subject specified.
Phone message title bar now displays caller's name.  This makes it easier to identify
message when you have multiple messages open.
Address Book tabs now filter entries by either caller's name or their organization.
Ok button in phone and text messages has been renamed to Send.
In the Address Book, the Name and From radio buttons now affect the filtering for the
address tabs in addition to incremental searching.
Fixed help file problem caused by Microsoft Security Update 896358.  Help file
installation is now configurable.
Fixed system shutdown problem again.
Fixed problem where forwarded phone messages are not included when messages are
emailed.
Fixed problem where double-clicking on a caller in the Caller Lookup window doesn't
select the caller and close the window.
Fixed size of Subject field in numerous places.
Fixed field sorting in personal folders.
Fixed problem with placement of cursor for messages that are being forwarded or
replied to.
Fixed user list problem in Receptionist Mode.
Fixed status bar message count problem in Receptionist Mode.
Various minor fixes.

Version 4.04 New version of DBBackup added.
Improved Address Book importing and exporting.
Email phone messages feature added.
Improved In-Out Board.
New License utility added.
Newer Version Check added.
Fixed printing problems.
Fixes double-clicking on messages in Folders.
Standard message printing fixed.
Fixed subject not appearing in Inbox.

Version 4.03 New Receptionist Access security feature added.
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Word, HTML and PDF exporting options added to print preview.
Caller Lookup facility added to phone messages.
New message notification options addedd.
UNC button added to DBConnect.  
New AutoComplete option added to Preferences.
Preferences window redesigned. 
Date and Time Stamp option added to message area popup menu in phone and text
messages.  
Removed Inbox button from message notification popup (this was redundant
functionality).  
Removed MIDAS.DLL dependency from DBRepair (it no longer requires this DLL).  
New Prompt to Save When Changed option added to Preferences. 
Address Book filtering problem - FIXED.  
Check box printing - FIXED.  
Message subject not being transferred to personal folders - FIXED.  
Miscellanous printing problem resolved. 

Version 4.02 Fixed problem with checkboxes not being checked in phone message printouts.
Fixed problem with PhonePad not allowing Windows to shutdown when running in
system tray.
Added Subject to phone message printouts.
Changed DBUpdate to use the data directory for temporary file storage during upgrades.

Version 4.01 Added automatic addressing option for phone and text messages.
Added option to exclude unused fields for message forwarding (SendAgent).
Added Subject to message forwarding.
Added Subject option to message forwarding.
Added sender's name and email address for message forwarding.
Fixed problem with duplicate recipients.
Fixed printing problem in Remote mode (IR55010259 and IR55010260).

Version 4.00 New internal database engine improves speed and data efficiency.
New ServerManager utility for administering and tweaking the PhonePad server
(DBServer).
Optional 128 bit encryption on all communications between PhonePad and DBServer.
Improved compression on PhonePad Internet connections.
Improved Address Book integration with Microsoft Outlook
Added new fields to the Address Book.
Added alphabetical tabs to the Address Book.
Added subject field to phone messages.
Added Show Inbox button to message notification dialog.
Added option to allow all messages to be marked as completed when one of the
recipients completes a follow up.
Added option to allow all message to be marked as read when one of the recipients
reads the message.
Added option to change color of message in Inbox only when follow up has been
completed.
Increased message font size for 4 to a page phone message printouts.
Changed follow up dialog to allow editing of notes after follow up has been completed.
Fixed problem with typed in recipients not being recognized.
Fixed problem with creating multiple phone and text messages simultaneously.
Fixed user list problem in Receptionist mode.
Minor changes to user interface in all modules.
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Version 3.17 Added Hidden option for users added to PhonePad Admin allows users to be excluded
from Receptionist list and recipient lists.
Added centralized preferences.
Added Public folders option.
Added message list sorting for ascending and descending order.
Now remembers sort order for each message list.
Added Inbox message list printing.
Added default font setting options for telephone and text messages.
Added Automatic followup option.
Added Customizable telephone message labels.
Added option to export messages to CSV format for importing into spreadsheets.
Added new Label Editor to provide custom label editing facility.
Removed Telephone Message Title option from Preferences (this is now done in the
Label Editor).
Fixed problem with maximum users in DBServer.
Fixed problem with In-Out Board status list.  (IR55010204)

Version 3.16 Added option for specifying location of license key file.
Extended email field in Address Book to 80 characters.
Fixed caller updating problem.  (IR55010181)
Fixed problem with receptionists not being able to read private messages sent to them.
(IR55010183)
Fixed problem with printing multiple phone messages.  (IR55010179)
Updated help.

Version 3.15 Fixed problems with recipient list in messages.
New icons for PhonePad and PhonePad Admin.
New icons for PhonePad toolbar and sidebar.
Replaced system tray message notification icons.
Miscellaneous minor fixes.
Update Installation Manual.
Updated help.

Version 3.14 New options for caller details in Phone Messages.  (Feature Request #IR55010100)
"From" field in Phone Messages is now a drop-down list.  (Feature Request
#IR55010059)
"Message Deleted" dialog can now be turned off.
New system settings added to DBConnect.
Fixed message printing problem.
Fixed message list refreshing problem after deletions.  (IR55010119)
Minor fixes.
Updated help.

Version 3.13 Fixed "frozen application" problem.
Added code to fix errors with users table.
Minor fixes.

Version 3.12 Added ability to customize phone message title.
Added ability to move messages to and from Sent folder.  (IR55010095)
Added server testing facility.
Added manual sorting to In-Out board status list.
Added option to print messages without previewing.



PhonePad Help8

Copyright © Cybercom Software

Administrators can now edit and delete Address Book entries created by other users.
(IR55010098)
Personal folders could not be deleted - fixed.  (IR55010094)
Updated message details don't appear in Inbox list - fixed.  (IR55010097)
Error when setting follow up status of messages - fixed.  (IR55010096)
Minor fixes.

Version 3.11 New icon for PhonePad.
When replying to messages, message field is now automatically focused.  Feature
Request #IR55010073.
Search function fixed.  (IR55010043)
Error when exporting messages - fixed.  (IR55010048)
Unknown recipients when addressing messages - fixed.  (IR55010049, IR55010068,
IR55010070)
New text message retains message contents after replying to a previous text
message - fixed.  (IR55010067)

Version 3.10 Changed all help files to HTML Help format.
New DBRepair 2.00 replaces old DBRepair utility.
Added SMTP support to SendAgent.
Updated DBBackup support files.
PhonePad now shuts down if connection to server is lost. (IR55010024)
Moving messages problem fixed. (IR55010028)
Data update error fixed. (IR55010027)
Fixed problem with spaces in recipient's names. (IR55010021)
Fixed problem with flashing notification.  (IR55010032)
Minor fixes.

Version 3.09 Added two new options for received messages in Preferences:
- Allow/disallow editing of received messages.
- Allow/disallow changing of caller details for received messages.
Fixed problem with Caller Time Lookup feature.
Added message receipts..
Added mouse support to drop-down recipient list.
Added message editing for received text messages.
Fixed message sorting in personal folders message list.

Version 3.08 Added Recipient Lookup List to phone and text messages.
Added Private Messages option to phone and text messages.
Added Folder Manager for managing personal folders.
Added new database verification and locating features to DBConnect.
Fixed PhonePad and Inbox shutdown problem.
Minor changes and bug fixes.
Minor database changes.

Version 3.07 In-Out Board: Window can now be resized.
In-Out Board: Remembers window position and size.
In-Out Board: Remembers column widths in status list.
In-Out Board: Users now sorted in alphabetical order.
In-Out Board: Optional log file.
In-Out Board: Columns can be sorted by clicking column headings.
DBServer: Fixed problem with remote login when setting up server.
Help files updated.
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Version 3.06 Increased size of email field in Address Book.
Added configurable system settings in DBConnect.
Changes to improve robustness.
Fixed problem with database shutdown feature where PhonePad is installed on
individual workstations.
Fixed Run on Startup problem - it couldn't be turned off.
Changes to repair process in PPAdmin and DBRepair.
Upgrade of internal database engine.

Version 3.05 Messages can be marked as completed without the need to mark them for follow up
first.
When exporting messages, follow up notes are now included.
Notes can be added directly to message text for received messages.
The In-Out Board can now be started minimized and can also run from the system tray.

Version 3.04 Added <ctrl-tab> shortcut to Phone Message window (allows you to tab out of the
message area).
Added new option to Preferences for Receptionist mode for receiving notification of new
messages for other users.
Added new In-Out Board for checking availability of staff.
Added new options to Preferences for In-Out Board.
Changed Run on Startup option under Preferences.  This option can now be enabled/
disabled easily.

Version 3.03 Due to a bug in a 3rd party component, Receptionist mode was broken in 3.02.  This
has been fixed in this release.

Version 3.02 Fixed Windows shutdown problem.
Fixed taskbar notification problem.
Fixed Inbox switching problem in Receptionist mode.

Version 3.01 Changes in PhonePad broke SendAgent - fixed.
Notification not working correctly - fixed.
Fixed 8708 database error.
Added INI file option to specify location of license key file.
Minor fixes.

Version 3.00 Added multiple message capability.
Added remote network (client/server) functionality.
Added message exporting.
Improved Address Book exporting.
Added phone number lookup for phone messages.
Text messages can now be resized.
Added Distribution Groups.
Added selectable phone number updating.
Added new options to Preferences.
Updated database engine.
Added new licensing system.
Added system information.

Version 2.20 Changes made to improve performance on some networks.
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Version 2.19 Changed inbox checking so that message delivery is now immediate.
Added Inbox message filtering.
Added sorting to Address Book.
Added incremental searching to Address Book.
Added printing for follow ups.
Set database connection polling to off as default.
Added database connection polling option to PhonePad Admin.
Fixed archiving problem in PhonePad Admin.
Fixed user deleting problem in PhonePad Admin.
Fixed Inbox selection problem.
Fixed license information in PhonePad Admin About box.
Fixed message text problem when printing phone messages one-to-a-page.

Version 2.18 Maintenance release.
Fixed Access Violation and Illegal Operation problems with systems running in Large
Fonts mode.

Version 2.17 Maintenance release.
Added INI file option to disable database polling feature.
Added new DBConnection utility.

Version 2.16 New Multiple Recipient support.
Added database connection polling.
NewCaller Time Lookup.
Sortable message lists.
Improved printing options
Fixed notification bug.
Minor bug fixes.

Version 2.15 Maintenance release.  New versions of PhonePad, PhonePad Admin, SendAgent and
DBUpdate.
Upgrade of internal database engine.
Minor bug fixes.

Version 2.14 Maintenance release.  New versions of PhonePad Admin and DBUpdate.

Version 2.13 New DBUpdate automatically handles the creation and updating of the PhonePad
database.
New DBBackup helps you protect your data by providing a way for you to backup your
data regularly.

Version 2.12 New search feature.
Added notes for completed calls.
Move messages to the Inbox.
Customisable font size for message form controls.
Enter key acts like tab key when creating messages.
Additional Address Book fields.
Fix deletion problem.
Minor bug fixes and improvements.

Version 2.11 All bug fixes were in the Receptionist Mode:
- User list didn't display any names in v2.10.  This was due to a bug with a 3rd party
component we use.  It sometimes drops properties at compile time.  FIXED.
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- User list displayed when viewing Sent box or personal folders - disabled this to avoid
confusion.
- Unable to delete other user's Inbox messages.  FIXED.
Minor bug fixes.

Version 2.10 Added text messages. Added forward and reply. Added message follow up. Added
personal folders. Added new status icons. Added automatic message forwarding.
Added message color options. Added message ID options. Added Inbox switching.
Added instant message checking. Added prompt when updating callers. Added new
printing options for phone and text messages. Added new error handling system. Added
editable date and time fields to phone messages. Updated print engine. Fixed bug that
brought main window forward whenever Inbox was checked. Fixed notification message
so that it is topmost window on desktop. Some other minor enhancements and bug
fixes.

Version 2.09 Fixed problem with message preview and printing.  On some systems, message would
appear as black blobs when previewed or printed.  Updated print engine.

Version 2.08 Improved printing. Added multiple message printing. Added multiple message deleting.
Fixed problem with page options on message printing. Added database location
selection to PhonePad Admin.

Version 2.07 Added Importing option. Added popup message when new messages are received.
Fixed a minor bug with message status updating that caused a database engine error.
Added code to fix appearance when using Large Fonts.

Version 2.06 Added phone number dialing. Fixed some minor bugs.

Version 2.05 Added the notification sound option. Fixed some minor bugs.

Version 2.04 Added startup options.

Version 2.03 Added color coding for messages.  Archiving facility added to PhonePad Admin.

Version 2.02 Added new Receptionist Mode.

Version 2.01 Fixed a problem with evaluation periods expiring prematurely.

Version 2.00 Initial release.

1.3 What's New

1.3.1 What's New in Version 2.01

Welcome to PhonePad v2.01.

PhonePad has the following new features and enhancements:

Improved Inbox.  Icons indicate message priority and status.
Improved Navigation.  New sidebar makes it easier to access PhonePad's many features.
New Sent Folder.  Keep a copy of all messages you have sent.
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New Login Options.  Login using your Windows username or username and password.
Address Book.  Replaces Frequent Callers facility.  Has improved editing facilities and privacy
options.
Message Notification.  Beeps and window flashing alert you when new messages are received.
New Look Messages.  Messages now have a paper-based look.
Rich Text Formatted Messages.  Message text can have different fonts, styles, colors and sizes,
etc.
Improved Message Printing.  Printed messages mimic paper based message pads.
New PhonePad Administration Utility.  Improved administration options for administrators.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.2 What's New in Version 2.02

Welcome to PhonePad v2.02.

PhonePad has the following new features and enhancements:

Receptionist Mode.  The new Receptionist mode allows specific users to check the Inboxes of
other users.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.3 What's New in Version 2.03

Welcome to PhonePad v2.03.

PhonePad has the following new features and enhancements:

Message Color Coding.  Messages that appear in the Inbox and Sent Folder are now color-coded,
making it easy to quickly identify the status of each message.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!
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1.3.4 What's New in Version 2.04

Welcome to PhonePad v2.04.

PhonePad has the following new startup options:

Run from System Tray.  You can now configure PhonePad to run from the system tray.
Run on Windows Startup.  This option will run PhonePad every time Windows starts.
Run Minimized.  You can have PhonePad automatically minimize whenever it is started.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.5 What's New in Version 2.05

Welcome to PhonePad v2.05.

PhonePad has the following new startup options:

Audible Notification.  PhonePad can now play a sound of your choice whenever new messages
are received in your Inbox..

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.6 What's New in Version 2.06

Welcome to PhonePad v2.06.

PhonePad has the following new startup options:
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Phone Dialing.  If you have a modem attached to your computer, PhonePad can dial the phone
number in a telephone message for you.  See Dialing Phone Numbers.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.7 What's New in Version 2.07

Welcome to PhonePad v2.07.

PhonePad has the following new startup options:

Address Book Importing.  Import Address Book entries from a comma delimited text file or
Microsoft Outlook.  See Importing Address Book Entries.
Popup Message.  Displays a popup message whenever new messages are received.  See
Preferences.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.8 What's New in Version 2.08

Welcome to PhonePad v2.08.

PhonePad has the following new startup options:

Improved Printing.  You can now print just one message or multiple messages.
Message Deletion.  Multiple messages can be deleted simultaneously.

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!
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1.3.9 What's New in Version 2.09

Welcome to PhonePad v2.09.

PhonePad has the following new startup options:

Fixed a problem with message previewing and printing.  On some systems, message would appear
as black blobs when previewing or printing..

For more information, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!

1.3.10 What's New in Version 2.10

Welcome to PhonePad v2.10.

PhonePad has the following new features:

Text Messages.  In addition to sending phone messages, you can now send quick messages to
other users.
Forward and Reply.  Forward messages to someone else or reply to messages you have received.
 This applies to phone messages as well as the new text messages.
Follow Up Messages.  Mark messages to be followed up, and mark them as completed when they
have been done.
Personal Folders.  Create personal folders for storing your messages.  Move messages between
folders.
New Status Icons.  New status icons have been added to indicate message status, message type,
and follow up status.
Message Forwarding.  Have messages forwarded to an email address when you are out of the
office.  New SendAgent automatically handles this.
Message Color.  Customize message color to suit your preferences.
Message ID.  Optionally display the Message ID on screen and in messages.
Switch to Inbox Option.  Set PhonePad to automatically switch to the Inbox whenever new
messages are received.
Instant Message Checking.  You can now set the Inbox to receive messages virtually as soon as
they are sent.
Prompt When Updating Callers.  In addition to being optionally prompted when adding new callers
to the Address Book, you can now have PhonePad prompt you before updating caller entries.
New Printing Options.  Telephone messages can either be printed one-to-a-page or four-to-a-page.
Editable Date and Time.  The date and time in phone messages can now be edited.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
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to come!!  Keep your suggestions and ideas coming!!!

1.3.11 What's New in Version 2.11

Welcome to PhonePad v2.11.

Refer to Version History for a list of bug fixes.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.12 What's New in Version 2.12

Welcome to PhonePad v2.12.

PhonePad has the following new features:

Searching.  Search for messages in the Inbox.
Returned Call Notes.  Add notes when you return calls.
Move Messages to Inbox.  Messages can now be moved from personal folders back to the Inbox.
Expanded Address Book.  The Address Book now has a lot more fields for your caller information.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.13 What's New in Version 2.13

Welcome to PhonePad v2.13.

PhonePad has the following new features:

New DBUpdate makes creating and updating the PhonePad database quick and easy.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.14 What's New in Version 2.14

Welcome to PhonePad v2.14.

PhonePad has the following new features:
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Maintenance release.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.15 What's New in Version 2.15

Welcome to PhonePad v2.15.

PhonePad has the following new features:

Maintenance release.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.16 What's New in Version 2.16

Welcome to PhonePad v2.16.

PhonePad has the following new features:

Multiple Recipient Support.  Now you can send messages to more than one recipient.  Essential
for those important messages to make sure they get through to someone.
Caller Time Lookup.  Find out what time it is in the caller's location before you call them.
Sortable Message Lists.  Now you can sort messages in the Inbox, Sent folder, etc.  Just click on
the column heading to sort.
Database Connection Polling.  Helps overcome data connection problems on networks with
transient drive connections.
Improved Printing Options.  New options for printing phone messages.
Expanded Address Book.  The Address Book has been expanded to allow you to store more
information about each caller.
Plus many minor improvements.

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.17 What's New in Version 2.17

Welcome to PhonePad v2.17.

PhonePad has the following new features:
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Database Polling Override.  Added setting to PHONEPAD.INI to allow database polling to be
turned off..

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.18 What's New in Version 2.18

Welcome to PhonePad v2.18.

PhonePad has the following new features:

Maintenance release..

For more information about PhonePad, read the Introduction to PhonePad.

We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.19 What's New in Version 2.19

Welcome to PhonePad v2.19.

PhonePad has the following new features:

Immediate Inbox Checking.  You might notice that the Inbox checking option is missing under
Preferences.  With this release there is no need to specify the frequency of message checking - it is
now virtually immediate.
Inbox Message Filtering.  You can now get the Inbox to show you only the messages you want. 
Filter messages by All Messages, Unread Messages, Read Messages, Uncompleted Followups,
Completed Followups, Urgent, Phone Messages and Text Messages.
Sortable Address Book list.  Columns can now be sorted in the Address Book by clicking on the
column headings.
Incremental searching in Address Book.  A  new incremental searchfeature allows you to quickly
find the information for a caller.
Followup Notes Printing.  You can now print the notes to followups that have been completed (this
is only a basic printing facility at the moment - we intend to improve this).

Changes and bug fixes:

Database connection polling is now off by default.  To enable this feature, run PhonePad Admin and
select Database Connection Polling from the Tools menu.  If you have PhonePad installed on
individual workstations, you will need to copy the PHONEPAD.INI file to each of these workstations.
Inbox selection problem - fixed.

For more information about PhonePad, read the Introduction to PhonePad.
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We are already working on the next version so there are plenty of more new features and enhancements
to come!!  Keep your suggestions and ideas coming!!!

1.3.20 What's New in Version 3.00

Welcome to PhonePad v3.00.

PhonePad has the following new features:

Multiple Messages.  You can now create and view multiple messages simultaneously.  No need to
close a message before creating a message or viewing another one.  You can have them all open at
the same time.  
New Connection Modes.  Now PhonePad can be used in three connection modes.  PhonePad can
be run across peer-to-peer networks, local area networks (LANs), wide area networks (WANs), and
the Internet.  You can even check your messages from home!  A PhonePad Server is included for
the remote modes.
Distribution Groups.  If you regularly send messages to the same people, you can now set up
Distribution Groups.  Send a message to a group and everyone in the group will receive the
message.
Improved Address Book Exporting.  You can now specify the fields you want to export and the
format to use.  See Exporting the Address Book for more information.
Message Exporting.  This new feature allows you to export your messages to text files for storing.
Selectable Phone Numbers in Messages.  Each caller can have four different phone numbers.
Now you can now select the appropriate number for the caller from a popup list.
Selectable Phone Number Updating.  You can choose to select which phone number is
automatically updated when the caller's number changes.
New Preferences.  Several new user preferences give you even more flexibility.
New Utilites.  A bunch of new utilities are included to assist you with setting up and maintaining
your PhonePad system.  See What's Included with PhonePad for more information.
Plus many minor changes to make PhonePad easier to use.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.21 What's New in Version 3.01

Welcome to PhonePad v3.01.

There are no new features in this release.  The following problems have been fixed:

Changes in PhonePad broke SendAgent - fixed.
Notification not working correctly - fixed.
Fixed 8708 database error.
Added INI file option to specify location of license key file.
Minor fixes.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.
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1.3.22 What's New in Version 3.02

Welcome to PhonePad v3.02.

There are no new features in this release.  The following problems have been fixed:

Fixed Windows shutdown problem.
Fixed taskbar notification problem.
Fixed Inbox switching problem in Receptionist mode.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.23 What's New in Version 3.03

Welcome to PhonePad v3.03.

There are no new features in this release.  The following problems have been fixed:

Fixed problem with user list in Receptionist mode (this was caused by a bug in a 3rd party
component).

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.24 What's New in Version 3.04

Welcome to PhonePad v3.04.

PhonePad has the following new features:

New In-Out Board.  Keep track of staff with the In-Out Board now included with PhonePad.
In-Out Board Options.  Options for In-Out Board have been added to Preferences.
Keyboard Shortcut for Phone Messages.  Use <ctrl> <tab> to tab out of the message area when
creating phone messages.
Message Notification for Other Users.  An option has been added to preferences that allows you
to switch message notification for other users on or off (Receptionist mode only).

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.25 What's New in Version 3.05

Welcome to PhonePad v3.05.

PhonePad has the following new features:

New In-Out Board Settings.  Additional preferences have been added for the In-Out Board: close
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when PhonePad closes, run from the system tray, start minimized.
Follow Up Messages.  Messages can now be marked as completed without the need to mark
them for follow up first.
Message Exporting.  When exporting messages, follow up notes are now included.
Message Editing.  Notes can now be added directly to message text after they have been received.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.26 What's New in Version 3.06

Welcome to PhonePad v3.06.

There are no new features in this release.  The following changes have been made to PhonePad:

The size of the email field in the Address Book has been increased to allow for large email addresses.
System setting options have been added to DBConnect to allow fine tuning on networks experiencing
speed and other problems.
Improvements made to help improve robustness and reduce incidents of data corruption.
Fixed PhonePad database shutdown option in PhonePad Admin.
Fixed Run on Startup option in PhonePad Preferences.
Changes made to repair process in DBRepair and PhonePad Admin.
PhonePad's internal database engine upgraded to latest version.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.27 What's New in Version 3.07

Welcome to PhonePad v3.07.

The following new features have been added to the PhonePad system in this release:

In-Out Board:  
Main window can now be resized.
Main window remembers window size and position.
Status list remembers column widths.
Status list columns can be sorted by clicking on column heading.
User names now sorted in alphabetical order by default.
Optional log file can log user status changes.

DBServer.  Fixed problem with remote login problem when setting up server.

Help files have been updated.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.
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1.3.28 What's New in Version 3.08

Welcome to PhonePad v3.08.

The following new features have been added to the PhonePad system in this release:

Recipient Lookup List.  The new recipient lookup list provides a drop-down incremental search
facility that provides a way to quickly select users to send phone and text messages to.
Private Messages.  Now phone and text messages can be marked as private.  This means only the
sender and recipients can read the messages.  Not even a receptionist can read them (unless they
are either the sender or a recipient).
Folder Manager.  The new Folder Manager makes it easy to create and manage personal folders.
Database Verification and Location.  DBConnect has a new feature that allows you to verify that
the selected directory contains the PhonePad database, and a search feature that finds the database
location for you.

The following fixes are included in this release:

The notorious shutdown problem has been fixed.
Minor bug fixes.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.29 What's New in Version 3.09

Welcome to PhonePad v3.09.

The following new features have been added to the PhonePad system in this release:

Message Receipts.  Now you can be notified when recipients have read a message with new
message receipts.
Text Message Editing.  Like phone messages, now received text messages can also be edited.
Phone Message Caller Editing.  Caller details can now be changed for received phone messages.
New Options in Preferences.  New options allow enabling/disabling of message and caller details
editing in received messages.

The following changes/fixes are included in this release:

Fixed problem with Caller Time Lookup feature.
Added mouse support for drop-down recipient list.
Sorting of messages in personal folders list now works.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.30 What's New in Version 3.10

Welcome to PhonePad v3.10.
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The following new features have been added to the PhonePad system in this release:

New DBRepair 2.00.  New and improved DBRepair 2 for maintaining your PhonePad database.
SendAgent SMTP Support.  SendAgent now supports the Simple Mail Transport Protocol
(SMTP), allowing messages to be forwarded via your SMTP server or MAPI.
HTML Help.  All help files have been converted to the easier-to-use HTML Help format.

The following changes/fixes are included in this release:

Updated DBBackup support files.
PhonePad now shuts down if connection to server is lost. (IR55010024)
Moving messages problem fixed. (IR55010028)
Data update error fixed. (IR55010027)
Fixed problem with spaces in recipient's names. (IR55010021)
Fixed problem with flashing notification.  (IR55010032)
Minor fixes.
Updated Installation manual.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.31 What's New in Version 3.11

Welcome to PhonePad v3.11.

The following new features have been added to the PhonePad system in this release:

No new features.

The following changes/fixes are included in this release:

New icon for PhonePad.
When replying to messages, message field is automatically focused.  Feature Request
#IR55010073.
Search function fixed.  (IR55010043)
Error when exporting messages - fixed.  (IR55010048)
Unknown recipients when addressing messages - fixed.  (IR55010049, IR55010068, IR55010070)
New text message retains message contents after replying to a previous text message - fixed. 
(IR55010067)

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.32 What's New in Version 3.12

Welcome to PhonePad v3.12.

The following new features have been added to the PhonePad system in this release:
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Customizable Phone Message Title.  The phone message title can now be changed from While
You Were Out to whatever you like, eg. Phone Message.
Message Moving for Sent Folder.  Messages can now be moved to and from the Sent folder.
(Feature Request #IR55010095)
Server Testing.  DBConnect can now test the connection between PhonePad and the PhonePad
server for those setting up PhonePad to run in remote mode (across LANs, WANs or the Internet).
In-Out Board Sorting.  The status list in the In-Out Board can now be manually sorted, ie. you can
drag n' drop the position of each user in the list and it will remember the order.
Print Without Preview.  When printing messages, you now have the choice of printing without
displaying a preview.

The following changes have been made in this release:

Administrators can now edit and delete Address Book entries created by other users.  (Feature
Request #IR55010098)

The following problems have been fixed in this release:

Personal folders could not be deleted - fixed.  (IR55010094)
Updated message details don't appear in Inbox list - fixed.  (IR55010097)
Error when setting follow up status of messages - fixed.  (IR55010096)
Minor fixes.

There may have been additional changes since this help file was compiled.  Check Readme.rtf for the
latest changes.

1.3.33 What's New in Version 3.13

Welcome to PhonePad v3.13.

Some users were receiving a message that PhonePad was frozen.  This error was misleading - it was
generally caused by a slow response from busy networks.  This has been corrected.
Minor fixes.

1.3.34 What's New in Version 3.14

Welcome to PhonePad v3.14.

This version of PhonePad includes the following changes:

New options for caller details in Phone Messages.  (Feature Request #IR55010100)
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"From" field in Phone Messages is now a drop-down list.  (Feature Request #IR55010059)
"Message Deleted" dialog can now be turned off.
New system settings added to DBConnect.
Fixed message printing problem.
Fixed message list refreshing problem after deletions.  (IR55010119)
Minor fixes.
Updated help.

1.3.35 What's New in Version 3.15

Welcome to PhonePad v3.15.

This version of PhonePad includes the following changes:

Fixed problems with recipient list in messages.
New icons for PhonePad and PhonePad Admin.
New icons for PhonePad toolbar and sidebar.
Replaced system tray message notification icons.
Miscellaneous minor fixes.
Update Installation Manual.
Updated help.

1.3.36 What's New in Version 3.16

Welcome to PhonePad v3.16.

The following new features have been added to the PhonePad system in this release:

License Key File - You can now specify the location of the PhonePad license key file in DBConnect.
This means that you can store the license key in a more convenient location if required.  Also includes
a facility for checking your license key.

This version of PhonePad includes the following changes:

Extended email field in Address Book to 80 characters.

The following problems have been fixed in this release:

Fixed caller updating.  (IR55010181)
Fixed problem with receptionists not being able to read private messages sent to them.  (IR55010183)
Fixed problem with printing multiple phone messages.  (IR55010179)
Updated help.

1.3.37 What's New in Version 3.17

Welcome to PhonePad v3.17.
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The following new features have been added to the PhonePad system in this release:

Exclude Users from Recipient Lists - Users can now be excluded from the Receptionist list and
recipient lists.
Public Folders - Personal folders can now be made public, allowing them to be shared between
users.
Sortable Message Lists - Message lists can now be sorted in both ascending and descending
order.  PhonePad remembers the sort order for each list.
Inbox Message List Printing - The Inbox message list can now be printed out. 
Default Message Font Settings - You can now set default font types and sizes for the message
area of telephone and text messages.
Automatic Follow Ups - Telephone messages can be set to automatically be followed up.
Customizable Phone Message Labels - Some of the labels in telephone messages can now be
customized.
Export Messages to CSV Format - A new export option allows phone and text messages to be
exported in CSV format for importing into spreadsheets.
Centralized Preferences - Centralized settings can be created that are accessed by all users.
They can also be locked so the settings can't be changed.

This version of PhonePad includes the following changes:

The Phone Message Title option has been removed from Preferences.  Please use the new Label
Editor to customize your phone message title.  Click here for more information.

The following problems have been fixed in this release:

Fixed problem with In-Out Board status list.  (IR55010204)
Fixed problem with maximum users in DBServer.
Minor fixes.
Updated help.

1.3.38 What's New in Version 4.00

Welcome to PhonePad v4.00.

The following new features have been added to the PhonePad system in this release:

New internal database engine - PhonePad's new internal database engine improves speed and
reliability.  This will also allow the addition of some exciting new features in upcoming releases.
128 Bit Encryption - LAN, WAN and Internet connections can now be encrypted using Blowfish
encryption.
Improved Data Compression - User definable data compression to improve response times over
the Internet or network.
New ServerManager utility - New utility allows configuration and management of remote
connections and the PhonePad server.
Expanded Address Book - A large number of new fields have been added to the Address Book for
storing more information.  Alphabetical tabs have also been added.
User-configurable Address Book list - You can now specify which fields to display in the Address
Book list.
Improved integration with Microsoft Outlook™ - Importing from Outlook has been improved.
You can now also export data to Outlook, allowing you to add new contacts or update existing
ones.  Includes the ability to specify which fields to update.
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Subject Field In Phone Messages - Telephone messages now have a subject field.
Show Inbox button - The message notification dialog now has a Show Inbox button, enabling you
to instantly switch to the Inbox when a new message arrives.
Improved User Deletion - There are three options available when deleting users.
New Look User Interface - The user interface has been updated in all modules.
Plus more...

This version of PhonePad includes the following changes:

Added option to allow all messages to be marked as completed when one of the recipients
completes a follow up.
Added option to allow all message to be marked as read when one of the recipients reads the
message.
Added option to change color of message in Inbox only when follow up has been completed.
Increased message font size for 4 to a page phone message printouts.
Changed follow up dialog to allow editing of notes after follow up has been completed.
Added date and time stamp for followup notes.

The following problems have been fixed in this release:

Fixed problem with typed in recipients not being recognized.
Fixed problem with creating multiple phone and text messages simultaneously.
Fixed user list problem in Receptionist mode.

1.3.39 What's New in Version 4.01

Welcome to PhonePad v4.01.

The following new features have been added to the PhonePad system in this release:

Automatic message addressing (AutoAddress) - The new AutoAddress feature allows you to
specify default recipients for phone and text messages.
New features in SendAgent - You can now specify the sender's name and email address, as well
as the subject.

This version of PhonePad includes the following changes:

Added Subject field to message forwarding.

The following problems have been fixed in this release:

Fixed problem with duplicate recipients.
Fixed printing problem in Remote mode (IR55010259 and IR55010260).
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1.3.40 What's New in Version 4.02

Welcome to PhonePad v4.02.

This version of PhonePad includes the following changes:

Fixed problem with checkboxes not being checked in phone message printouts.
Fixed problem with PhonePad not allowing Windows to shutdown when running in system tray.
Added Subject to phone message printouts.
Changed DBUpdate to use the data directory for temporary file storage during upgrades.

1.3.41 What's New in Version 4.03

Welcome to PhonePad v4.03.

The following new features have been added to the PhonePad system in this release:

Receptionist Access - Receptionists no longer get automatic access to all Inboxes.  This new
feature allows you to specify which Inboxes receptionists can access.  Refer to the PhonePad
Admin module for more information.
Message Exporting - New export options have been added to the print preview window, allowing
you to export messages to Word, HTML and PDF files.
Caller Lookup - When composing phone messages, you can now popup the new Caller Lookup
window that shows all contacts in your PhonePad Address Book  This allows you to ensure you
select the correct caller when there are similar or identical names.
New Message Notification Options - New Popup Balloon and Alert Window expand the range of
message notification options available to you.

This version of PhonePad includes the following changes:

DBConnect has a new UNC button to convert the data directory to a UNC path.  
New AutoComplete option under Preferences allows you to turn off the caller autocomplete feature.

Date and Time Stamp option added to message area popup menu in phone and text messages.  

Removed Inbox button from message notification popup (this was redundant functionality).  
Removed MIDAS.DLL dependency from DBRepair (it no longer requires this DLL).  
New Prompt to Save When Changed option under Preferences allows you to disable save prompt
when changes have been made to a received message. 
Messages can now be marked as unread (popup menu in Inbox).
Change in message icons in message lists.

The following problems have been fixed in this release:

Address Book filtering problem - FIXED.  
Check box printing - FIXED.  
Follow up notes not being saved in phone message window - FIXED.
Message subject not being transferred to personal folders - FIXED.  
Miscellanous printing problem resolved. 
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1.3.42 What's New in Version 4.04

Welcome to PhonePad v4.04.

The following new features have been added to the PhonePad system in this release:

New Version of DBBackup - PhonePad's backup and restore facilities have been improved with a
new version of DBBackup.  You can now set DBBackup to automatically backup your PhonePad
data.  DBBackup can also perform backups while users are still logged in.
Improved Address Book Importing and Exporting - The importing and exporting functions in the
Address Book have been improved.  You can now export your Address Book to text files, Excel,
Word and HTML.
Email Phone Messages - Individual phone messages can now be emailed.
Improved In-Out Board - Drop-down list for notes, notes editing facility, preferences can now be
set within In-Out Board.
New License Utility - New License utility makes it easier to license PhonePad.
Newer Version Check - New menu option allows you to check for newer versions of PhonePad.

The following problems have been fixed in this release:

Printing problems - FIXED.
Double-clicking on messages in Folders does not display messages. - FIXED.
Standard message printing shows all checkboxes checked. - FIXED.
Subject not appearing in Inbox - FIXED.

1.3.43 What's New in Version 4.05

Welcome to PhonePad v4.05.

The following new features have been added to the PhonePad system in this release:

Message list report added to PhonePad Admin.  Also added ability to export report in CSV format.
Popup caller phone lookup dialog in phone messages has been improved (now includes 8 different
phone numbers) and now allows phone numbers to be edited.
New subject prefix option added.
Default subject when no subject specified.
Phone message title bar now displays caller's name.  This makes it easier to identify message
when you have multiple messages open.
Address Book tabs now filter entries by either caller's name or their organization.

The following changes have been made in this release:

Ok button in phone and text messages has been renamed to Send.
In the Address Book, the Name and From radio buttons now affect the filtering for the address tabs
in addition to incremental searching.

The following problems have been fixed in this release:

Help file problem caused by Microsoft Security Update 896358 - FIXED.  Help file installation is now
configurable.
System shutdown problem - FIXED again.
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Forwarded phone messages are not included when messages are emailed - FIXED.
Double-clicking on a caller in the Caller Lookup window doesn't select the caller and close the
window - FIXED.
Size of Subject field too short in numerous places - FIXED.
Field sorting in personal folders doesn't work correctly - FIXED.
Problem with placement of cursor for messages that are being forwarded or replied to - FIXED.
Inbox showing wrong messages on startup in Receptionist Mode - FIXED.
Status bar message count not displaying counts correctly in Receptionist Mode - FIXED.
Various minor fixes.

1.3.44 What's New in Version 4.06

Welcome to PhonePad v4.06.

The following new features have been added to the PhonePad system in this release:

Improved Licensing System.  License key files are now a thing of the past (well, almost).
License keys are now  embedded in the PhonePad database which means you no longer need to
have a license key file in your network drive or on each workstation.
SMS Support for Automatic Message Forwarding.  Yes, it's finally here.  Besides forwarding
messages via email, you can now send them to mobile/cell phones.
Multiple Email Addresses for Message Forwarding.  Automatic Message Forwarding now
supports multiple email addresses.  With the new SMS features it also supports multiple mobile/
cell phone numbers as well.
SendAgent is Now MessageSender.  SendAgent has had a facelift and is now called
MessageSender.  There have been various improvements including SMS capabilities.
Message Archiving.  Messages can now be archived from within PhonePad.
Message Broadcasting.  PhonePad Admin can now send broadcast messages to all PhonePad
users.  This can be used for notifying using of important system announcements, ask them to
logout, or let them know the pizza has arrived.
Logout Users.  PhonePad Admin has a new feature that can shutdown PhonePad across your
network, whether you are running PhonePad in Local or Remote mode.  This is ideal for system
maintenance tasks.
Server Announcement.  For those running PhonePad in Remote Mode, the PhonePad Server
(DBServer) includes an option for announcing it's IP address and ports, making it easy to configure
workstations.
Search Improvements.  Search can now search the message text area in messages.  New
options added to popup menu plus other improvements.

The following changes have been made in this release:

Caller Info feature now displays all details for callers.
Updated License.exe now download license keys from our server.

The following problems have been fixed in this release:

Message count was not displaying in Receptionist Mode - FIXED.
In Receptionist Mode, all messages would be displayed for a user when PhonePad starts up -
FIXED.
When sending a phone message, it would prompt for which phone number to update, even though
this is set to automatic. - FIXED.
Multiple email addresses had broken Email Sending feature. - FIXED.
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ALL button in Recipients selection window occasionally cause an error.  If the error message is
hidden, PhonePad appears to have frozen. - FIXED.
Various minor fixes.

1.3.45 What's New in Version 4.07

Welcome to PhonePad v4.07.

The following new features have been added to the PhonePad system in this release:

Improved Phone Number Editing.  The phone number lookup window has been improved to allow
you to add all phone numbers for new callers at the time of taking a phone message.
Support Center.  The new SupportCenter utility provides instant and convenient access to all
support resources available to you from one central location.  Just one click takes you to whatever
you need.
Added option to prevent messages from being sent if Subject field is blank.
Added option to disable mouse in Recipient List in phone and text messages.
Added user list refresh option to PhonePad Admin.
Added Log SMTP Responses option to MessageSender.
Added SMTP Email Formats to MessageSender.
Added ability to mark messages as Urgent after they have been received.
Added ability to lock Distribution Groups.
F6 key jumps to Subject field in phone and text messages.

The following changes have been made in this release:

No changes.

The following problems have been fixed in this release:

Messages that were marked as completed were resetting back to follow up - FIXED.
Fixed reports in PhonePad Admin.
Various minor fixes.

1.3.46 What's New in Version 4.08

Welcome to PhonePad v4.08.

The following new features have been added to the PhonePad system in this release:

Spell Checking.  PhonePad now features Spell Checking, including Live Spelling and AutoCorrect.
Added various SMTP Options to MessageSender preferences.
Added extra MessageSender logging option.

The following changes have been made in this release:

Major upgrade to PhonePad's printing and reporting engine.
When the Subject is changed in a received message, the subject field is now automatically updated
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in all Inboxes to match.
Caller details (Name and From) loading can be turned off.
Caller details loading multi-threaded to improve phone message load times.
Search function now supports searching archived messages.

The following problems have been fixed in this release:

PhonePad now remembers default print settings.
Fixed report in PhonePad.
Fixed report in PhonePad Admin.
Various minor fixes.

1.3.47 What's New in Version 4.09

Welcome to PhonePad v4.09.

The following new features have been added to the PhonePad system in this release:

Added attachment option to the Email Message feature.

The following changes have been made in this release:

Improved performance of DBUpdate by removing repair and optimization.

The following problems have been fixed in this release:

Fixed Access Violations errors with message printing.

1.3.48 What's New in Version 4.10

Welcome to PhonePad v4.10.

The following new features have been added to the PhonePad system in this release:

Custom Colors for Inbox Message List.  Now you can specify the color of messages that appear
in the Inbox message List.
Multiple Attachments for Email Message.  We have added multi-attachment support for the
Email Message feature so that you can now send more than one attachment.
Quick Phone and Text Messages.  Added options for creating phone and text messages from the
PhonePad system tray menu.

The following changes have been made in this release:

None.

The following problems have been fixed in this release:

Fixed problem with "expression" error in message printing
Fixed problem with Access Violations when two message are open simultaneously and sent.
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1.3.49 What's New in Version 4.11

Welcome to PhonePad v4.11.

The following new features have been added to the PhonePad system in this release:

System Tray Shortcuts.  Added shortcuts for Address Book and In-Out Board to the system tray
menu.

The following changes have been made in this release:

Added shortcut keys to message TimeStamp option.
AddressBook now remembers window size.

The following problems have been fixed in this release:

Fixed problem with "Message Sent" message.
Fixed problem "Table not in insert or edit mode" errors.
Minor fixes.

1.3.50 What's New in Version 4.12

Welcome to PhonePad v4.12.

The following new features have been added to the PhonePad system in this release:

Enhanced Caller Lookup.  When creating phone messages, the caller lookup feature has been
enhanced to be faster and show both caller and organization details.
Enhanced Address Book List.  The Address Book's contact list has better column sorting and
improved incremental search.  New settings have been added to improve performance for very large
Address Books.
Improved Archiving.  You can now archive messages without having to physically delete any
messages from each user's Inbox, Sent folder, or other folders.

The following changes have been made in this release:

Changed In-Out Board so "Back At" time can be blank.
Added new option to Preferences that will scroll the Inbox to the most recent message.

1.3.51 What's New in Version 4.13

Welcome to PhonePad v4.13.

The following changes have been made in this release:

Fixed problem with sorting in Address Book list where lower case names wouldn't sort properly.
Fixed problem where double-clicking on the Address Book list wasn't opening an entry for edit.
User passwords are now masked in PhonePad Admin and administrators are now required to confirm
passwords.
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1.3.52 What's New in Version 4.14

Welcome to PhonePad v4.14.

The following new features have been added to the PhonePad system in this release:

Import Users - PhonePad Admin can now import users in one batch via CSV or XML files.  This
should make it easier for networks with a lot of users.
New Reports - New statistics reports added to PhonePad Admin.

The following changes have been made in this release:

Added Refresh option to user list in Receptionist mode.
Added Quick Print option for printing messages in a compact format to save paper.

The following problems have been fixed in this release:

Fixed problem with message area default font not observing settings in Preferences.
Fixed problem with flash notification option continually flashing.
In Receptionist mode, the search option should search the selected user's Inbox - fixed.
Search not returning all results - bug in search code - fixed.
Fixed problem with PhonePad Admin starting with a blank user list when there was a database
connection error.
Fixed problem with user list in Receptionist mode showing blank entries.
Removed Logged In status from PhonePad Admin as it is not reliable.
Updated links in SupportCenter.

1.3.53 What's New in Version 4.15

Welcome to PhonePad v4.15.

The following new features have been added to the PhonePad system in this release:

Improved Follow Up Notes - Follow Up Notes have been improved significantly.  Now each
message can have an almost unlimited number of Follow Up Notes.
Message List Sorting - Now you can specify whether you want the latest message to appear at
the bottom or top of the message list.
Latest News - New Help menu option takes you to the latest news area on our website so you can
keep up to date with new releases, training materials, etc.
Install Help Files Locally - If you are running PhonePad from a network drive then you probably
already know about the infamous Microsoft Security Update that kills help files.  With this option
you can get your help files working again by installing them locally while still running PhonePad
from a network drive.

The following changes have been made in this release:

Updated message printing.
When phone messages are forwarded or replied to, the details and text from the phone message
are now included in the message area of the new message.
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The following problems have been fixed in this release:

Speed improvements.
Fixed text overlapping problem during printing.
Fixed issues with moving messages between folders.
Minor fixes and improvements.

1.3.54 What's New in Version 4.16

Welcome to PhonePad v4.16.

The following new features have been added to the PhonePad system in this release:

Caller ID - When the phone rings, PhonePad detects the caller's phone number and displays it in
a popup message.  But that's not all.  If the caller is in the PhonePad Address Book, PhonePad will
automatically look up and display the caller's details.  So you will know exactly who's calling before
you even answer the phone.  (Note: Requires a TAPI device to be connected to your computer.)

Received Calls Log - Using Caller ID functionality, PhonePad will automatically keep a record of
all received calls.  If you're away from your phone, you can view a list of all missed calls, create a
phone message, or even call them back.  (Note: Requires a TAPI device to be connected to your computer.)

Automatically Display New Messages - Set this option and messages will be automatically
display as you receive them.

The following changes have been made in this release:

Added feature that allows follow up notes to be assigned to another message.
Email Message feature can now use SMTP mail server as well as MAPI.

The following problems have been fixed in this release:

Fixed issue with follow up notes sometimes being assigned to the wrong message.
Fixed issue with new messages sometimes not being displayed in Inbox.
Minor fixes.

1.3.55 What's New in Version 4.17

Welcome to PhonePad v4.17.

The following new features have been added to the PhonePad system in this release:

New Email Settings - In addition to emailing messages using MAPI, you can use SMTP using a
variety of authentication methods.  See Email settings under Preferences for details.

1.3.56 What's New in Version 4.18

Welcome to PhonePad v4.18.

The following new features have been added to the PhonePad system in this release:
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Automatic Message Forwarding - Added new option that enables you to only forward Urgent
messages via email or SMS.  Also, added a new option to the Forward By PhonePad feature that
also you to prevent Private messages from being sent to other users.
Built-in Label Editor - The separate Label Editor utility is now gone. This functionality has now
been integrated into PhonePad Admin.  The custom labels are now stored in the PhonePad
database rather than in a separate Labels.ini file.
Automatic Message Moving - PhonePad now has an option for automatically moving read
messages to a private folder.

The following changes have been made in this release:

Changed Address Book so that only administrators can delete all entries.
Added option for disabling confirmation message when phone messages are canceled.
Added status report to PhonePad Admin that shows that status of all messages in each user's
Inbox.
Changed format of trace logs to XML.
Administrators can now view Private folders.

The following problems have been fixed in this release:

Fixed issue with Follow Up Notes list not clearing when selecting another folder.
Fixed issue with Forward By PhonePad feature (under Automatic Message Forwarding) not working
under some circumstances.
Fixed issue Caller Lookup entries not being deleted when the corresponding Address Book entry is
deleted.
Fixed Subject wrapping issue on some printouts.
Fixed SQL error that occurs when names contain apostrophes.
Fixed encrypted connection issues.
Fixed issue with DBRepair repair log.
Automatically updates local help files if required.
Other minor fixes.

1.3.57 What's New in Version 4.19

Welcome to PhonePad v4.18.

The following problems have been fixed in this release:

Fixed speed issues and errors on searches.
Fixed text printing errors.
Fixed missing message icons on search results.
Fixed issue with wrong follow up details being displayed when editing or viewing follow up notes in
personal folders.
Fixed issue with custom labels not being displayed in phone messages.
Added warning message when trial period or temporary license has 7 days or less to go.
Added option for selecting the TAPI device.
Other minor fixes.
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2 Getting Started

2.1 Main Window

The main window of PhonePad features menus, a toolbar, a sidebar, an Inbox, Folder Messages or Sent
Message list, Follow Up Notes, and a status bar.

2.2 Inbox

The Inbox displays a list of messages that have been sent to you.  Messages are listed in the order they
are received, with the most recent ones appearing at the bottom of the list.
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The Inbox displays the date and time of each message, the name of the caller and where they are from
(eg. their company).  You can view a message using a number of methods:

Double-click on the message
Click on the View button on the sidebar
Click on the View button on the toolbar
Select View Message from the File menu

Message Priority and Status

The status and priority of each message is indicated by an icon.

Indicates a message that has been read.

Indicates a message that has not been read.

Indicates an urgent message.

Black Indicates a message that has been read.

Blue Indicates a message that has not been read.

Red Indicates an urgent message.

Indicates the message is a telephone message.
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Indicates the message is a text message.

Indicates the message has been marked for follow up.

Indicates the message has been followed up.

User List

If you have been nominated as a Receptionist, a user list will appear to the left of the Inbox (see
Receptionist Mode).

Message Sorting

Messages can be sorted in the Inbox by clicking on the column heading.

You can also set the overall message order in a message list, ie. newest messages are shown at the
top or bottom.

Message Filtering

Inbox messages can also be filtered so that only the messages you want to see will be displayed.

Popup Menu

The Inbox message list has its own popup menu, which can be accessed by right-clicking on the
message list.
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2.3 Menus

The PhonePad menu bar has 3 menus.  Many of the menu items are also available from the toolbar and
sidebar.

File menu

New Phone Message Creates a new phone message.

New Text Message Creates a new text message.

View Message View the selected message (you can also double-click on the message).

Delete Message Deletes the selected message.

Sending Options

Forward Message Forward the selected message to another user.

Reply to Message Reply to the selected message.

Resend Message Resends the selected message.

Print Setup Allows you to specify the default printer.

Print Prints the selected message.

Dial Number Dials the caller's phone number in the selected message.
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Follow Up

Mark  for Follow Up Mark the selected message for following up.

Add Follow Up Note Add a new Follow Up Note.

Edit Follow Up Note Edit the selected Follow Up Note.

Delete Follow Up
N
o
t
e

Delete the selected Follow Up Note.

View Follow Up Note View the selected Follow Up Note.

Mark as Completed Indicate that the selected message has been followed up. 

Check Inbox Checks for new messages.

Exit Exits PhonePad.

Tools menu

Search Switches to the message search screen.

Address Book Displays the Address Book.

Distribution Groups Set up Distribution Groups for sending messages to.

Password Allows you to change your PhonePad password.

Preferences Allows you to customize various PhonePad settings.

Folder Manager Add, edit and delete personal and public folders.

Message Forwarding Allows messages to be forwarded to an email address.  (Not to be confused
with forwarding a message).

Export to CSV File Export selected messages to a text file in CSV (Comma Separated Value)
format.

Export to Text File Export selected messages to a text file.

In-Out Board Launches the built-in In-Out Board, allowing you to set your availability and to
check the status of other staff.

Help menu

Contents Displays online help (which you are now viewing).  You can also press the F1
key.

Latest News Opens your default Internet browser and takes you to the Cybercom Software
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Blog.

Cybercom Software
W
e
b
s
i
t
e

Opens your Internet browser and goes to the Download page on the
Cybercom Software website. 

System Information Displays information about the PhonePad system.  For more details: System
Information.

Support Center Launches the PhonePad Support Center, which allows you to access all
support resources from a central location.

Popup Hints Enables or disables popup hints. These are little yellow tips that are
displayed when you move the mouse over toolbar buttons.

About Displays version information.

2.4 Sent Messages

The Sent Messages list displays a list of all messages you have sent to other PhonePad users.
Messages are listed in the order they were sent, with the most recent ones appearing at the bottom of
the list.
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The Sent Messages view displays the date and time of each message, the PhonePad user the message
was sent to, and the name of the caller.  You can view a message using a number of methods:

Double-click on the message
Click on the View button on the sidebar
Click on the View button on the toolbar
Select View Message from the File menu

Message Priority and Status

The Sent List displays an icon for each message you have sent.  These icons tell you which messages
have been read or not read by the recipient.

Indicates a message that has been read by the recipient.

Indicates a message that hasn't been read by the recipient.

Indicates an urgent message that hasn't been read by the recipient.

Indicates the message is a phone message.

Indicates the message is a text message.

Sent messages can be resent by selecting the message and then by clicking the Resend button on the
toolbar (you can also click on the Resend button on the Sidebar, or by selecting Resend Message from
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the File menu).

Messages can be sorted in by clicking on the column heading.

2.5 Sidebar

Like the toolbar, the sidebar provides a number of shortcuts to PhonePad's features.  It is divided into
three groups: Inbox, Sent and Other.  Click on the group name to display the buttons for that group.
Click on a button to activate that function.  An arrow button in a group indicates that there are other
buttons that are currently hidden.  Click on the arrow button to display the other buttons.

Each of the groups has its own set of buttons:

Inbox

New Phone Create and send a new telephone message.
Message

New Text Create and send a new text message.
Message

View View the selected Inbox message.
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Delete Delete the selected Inbox message.

Print Print the selected Inbox message.

Forward Forward the selected message to another user.

Reply Reply to the selected message.

Dial Dials the caller's phone number in the selected message.

Check Inbox Manually check for new messages.

Sent

View View the selected Sent message.

Print Print the selected Sent message.

Delete Delete the selected Sent message.

Resend Resend the selected message.

Other

Address Book Display the Address Book.

Distribution Set up Distribution Groups for sending messages to.
Groups

Password Change your PhonePad password.

Preferences Customize PhonePad's settings.

Message Automatically forward messages to an email address.
Forwarding

In-Out Board Launches the built-in In-Out Board, allowing you to set your availability and to check the
status of other staff.

Folders Allows you to create your own folders for storing messages in.
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2.6 Status Bar

The Status Bar keeps you up to date with what is happening in PhonePad.

The Status Bar is divided into 5 sections.  The first section is the main part of the status bar, and it
displays status messages as well as hints (eg. when you move the mouse over the toolbar or menu
items, their function is displayed on the status bar).  The second, third and fourth sections display the
no. of Unread messages, Read messages, and the Total no. of messages, respectively.  The fifth
section displays the current date and time.

2.7 Toolbar

The Toolbar provides quick and easy access to many of PhonePad's features.  These functions are also
available in the menus, popup menus and in some cases on the sidebar.

3 Using PhonePad

3.1 Adding an Address Book Entry

Although PhonePad will automatically add new callers to the Address Book, you can also add new
entries manually.  The Address Book features fields for storing all of a caller's address information.
Fields are organized under tabs: Business Address, Postal Address, Home Address and Notes.  Only a
small number of these are actually used by PhonePad.  The remainder are for your convenience.
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To add a new caller, click on the Add button in the Address Book and complete the details.  Click OK to
save the information.

Images

Images can be added by right-clicking on the image area.

Load Image Add an image for the Address Book entry.

Save Image Save the Address Book entry image to file.

Clear Image Delete the image.

Buttons

OK Adds the new Address Book entry.

Cancel Cancels the additions you have made.
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Print Prints the Address Book entry.

Import Imports a contact from Microsoft Outlook™.

Export Exports the Address Book entry to Microsoft Outlook™.

Settings Allows you to specify which fields to import from or export to Microsoft Outlook™.

Help Displays online help (which you are now viewing).

Restrictions

Private If checked, this entry will only appear in your Address Book and will not be displayed in
the Caller drop-down list for other PhonePad users.

Updateable by If checked, other PhonePad users will be able to update the Address Book entry (both
automatically and manually).

The fields highlighted in cyan are used by PhonePad in phone and/or text messages (shown in magenta
on this page).  Other fields are for your own purposes and are not required by PhonePad - you can store
any information you like in these fields.

To open the Address Book:

Click the Address Book  button on the toolbar.

Or click the Address Book  button on the sidebar.

3.2 Address Book

If you have the Add New Callers to Address Book  option enabled under Preferences, any callers you
enter when sending a message will be automatically added to the PhonePad database if they don't
already exist.  

You can view these entries in the Address Book.  Click on the Address Book  button on the toolbar, or
click on the Address Book  button under Other on the sidebar, or select Address Book  from the Tools
menu.
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The Address Book displays all caller entries that have been created by you and other PhonePad users. 
The only exception to this is if the entries have been marked Private - only your Private entries will be
displayed.

Click on the Address Book column headings to sort entries.  Not all columns can be sorted though.  The
sortable columns are: Name, Firstname, Lastname, From, Telephone, City, State and Postal Code.

The Search Text area at the bottom of the Address Book  window provides an incremental search facility.
 As you enter text in the edit box, the Address Book  will incrementally search all entries, displaying only
those that match your search text.  You can search any column that is displayed by selecting the
column from the drop-down list to the right of the Search edit box.  Only those columns checked under 
Options will be available for searching.

A search can be cleared by clicking on the  button.

Along the bottom of the Address Book  window are set of tabs, one for each letter of the alphabet.
Clicking on these tabs will filter the entries in the list.  It works pretty much the same as tabs in a paper
address book.  For instance, if you click on A, only those entries starting with A will be displayed.  

The All tab displays all entries.

IMPORTANT:  If you have a large Address Book then you may want to modify some Address Book
settings under Preferences to improve performance.  For example, in the screenshot above the Address
Book has over 10,000 entries.  If the ALL tab is enabled it can slow things down considerably as the list
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has to "load" all 10,000 entries at once.  By disabling the ALL tab under Preferences it will only have to
load entries for the selected tab, eg. 'A', which will be a lot less.

Buttons

Close Close the Address Book.

Add Add a new Address Book entry.

Edit Edit the selected entry.

Delete Delete the selected entry.

Print Print a list of all Address Book entries.

Import Import Address Book entries from a text file.

Export Export Address Book entries from a text file.

Clear Empty the Address Book.

Options Allows you to specify which fields to display in the Address Book list.

Help Access online help.

To open the Address Book:

Click the Address Book  button on the toolbar.

Or click the Address Book  button on the sidebar.

3.3 Address Book Options

This dialog allows you to specify which Address Book fields you want displayed in the Address Book
list.
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To include a field, click on the check box next to the field name.

Ok Saves the changes you made to the field selections.

Cancel Cancels any changes you have made.

Help Displays online help.

3.4 Automatic Message Forwarding

PhonePad's Automatic Message Forwarding feature allows you to receive your messages when you're
out of the office.  Although they have a very similar name, Automatic Message Forwarding is not the
same as forwarding a message using the Forward Message option on the PhonePad main screen.

Forward Via PhonePad

If you are going to be away from the office for any length of time, you can tell PhonePad to forward your
messages to other PhonePad users.  For example, if you are going away on holidays you may want
someone else to handle the messages for you.
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Users are added by selecting the name from the drop-down list and clicking the Add button.  Users can
be removed by selecting the user from the list and clicking the Delete button.

You can prevent Private messages from being forwarded if you select the Do not forward PRIVATE
messages checkbox.

This feature can be quickly enabled or disabled by checking or unchecking the Automatically forward my
messages to these users checkbox.

Forward Via Email

If you're on the road, working from home, or otherwise not in the office, you can have your PhonePad
messages forwarded to one or more email addresses.
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Add email addresses by typing them directly into the list (as shown in the above screenshot).  Please
note: each email address must be on a separate line.

You can set PhonePad to only forward Urgent messages by checking the Only forward URGENT
messages via Email checkbox.

This feature can be quickly enabled or disabled by checking or unchecking the Automatically send
messages to the following email addresses checkbox.

IMPORTANT:  For message forwarding to work, you need to install the MessageSender add-on
application on one computer on your network.  MessageSender is available from the Cybercom Software
website under PhonePad Add-Ons.

Forward Via SMS

You can also have your PhonePad messages sent to your mobile/cell phone when you're out and about.
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Add phone numbers by typing them directly into the list (as shown in the above screenshot).  Please
note: each phone number must be on a separate line.

You can set PhonePad to only forward Urgent messages by checking the Only forward URGENT
messages via SMS checkbox.

This feature can be quickly enabled or disabled by checking or unchecking the Automatically send
messages to the following mobile/cell phones checkbox.

IMPORTANT:  For message forwarding to work, you need to install the MessageSender add-on
application on one computer on your network.  MessageSender is available from the Cybercom Software
website under PhonePad Add-Ons.  Additionally, the SMS feature also requires an account with an
SMS gateway provider (complete details are included with MessageSender).

3.5 Automatically Display Messages

If you enable the Auto-Display Messages option under Preferences, PhonePad will automatically display
messages as they are received.
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3.6 Broadcast Messages

PhonePad administrators have the facility for sending broadcast messages to all PhonePad users.  The
messages will be automatically displayed when they are received and will appear on top of all windows.

To close the message, click either the  button or the OK button.

3.7 Caller ID

If you have the Caller ID option enabled under Preferences, when your phone rings PhonePad will detect
the caller's phone number and display it in a popup message.
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If the caller is in the Address Book, PhonePad will automatically look up and display the caller's details.
This all happens before you even answer the phone.  If you click the Take a Message button, PhonePad
will open a new phone message and pre-fill the caller details for you, saving you time and effort.

The Received Calls feature uses Caller ID to keep a record of all phone calls received, including missed
calls.

Important Note:  For Caller ID to work, you must have a TAPI device (eg. a TAPI modem)
connected to your computer and a telephone.

3.8 Caller Lookup

The Caller Lookup window is displayed by clicking on the Caller button while creating a new phone
message.
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This window allows you to scroll through all of the entries in the Address Book without having to open
the Address Book itself.  The Search Text edit box allows you to perform incremental searches on
names in the Caller Lookup window.

Selecting an entry will display some of the caller's details.

3.9 Caller Time Lookup

You may receive phone messages from callers located in different time zones, within your own country
or overseas.  The Caller Time Lookup feature allows you to check what time it is in the caller's location,
just so you don't ring them up at 2:00 in the morning!!  

To use this feature, click on the  icon in a phone message.
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If the phone number is in the correct format, the Country Code and/or Area Code will be looked up.  If
PhonePad has the information for the particular country, a window will appear showing the time zone
information of the caller.

The window displays your current date and time, as well as the caller's date and time.  It also shows the
Universal Coordinated Time (UTC)*, which is expressed in minutes relative to the date and time in
Greenwich, England.  As you can see from this example,.it probably wouldn't be a good time to phone
the caller, unless they are a very early riser!!  

You may also notice there is a details tab.  This contains the caller's Address Book information - it
saves you having to close this window and the message and open up the Address Book to get the
caller's other details (eg. cell phone/mobile phone number).

Limitations

This facility does not take daylight savings time (DST) into account, due to the complexity of DST (it
varies from country to country, year to year).  However, we are looking at adding this to a future version
of PhonePad.

* No, this is not a mistake.
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3.10 Changing Your Password

You can change your password at any time by clicking on the Password button on the toolbar or sidebar
, or by selecting Change Password from the Tools menu.

To change your password, you need to enter your current password and then enter the new password. 
You need to enter the password a second time to verify that it is correct.  Click Ok  to change the
password or Cancel to keep the existing password.

To select the Change Password option:

Click the Password button on the toolbar.

Or click the Password button on the sidebar.

3.11 Checking the Inbox for New Messages

PhonePad automatically checks for new messages and updates the Inbox.  You can also manually
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check for new messages by clicking on the Check Inbox button on the toolbar, or by selecting Check
Inbox from the File menu, or by clicking on the Check Inbox button on the sidebar.

Whenever new messages are received, the Unread and Total messages indicators on the status bar are
also updated.

To check the Inbox manually:

Click on the Check Inbox button on the toolbar.

Or click on the Check Inbox button on the sidebar.

3.12 Connection Modes

With the introduction of PhonePad 3, you can now connect to your PhonePad data in either local or
remote mode.  The mode you use depends on the type of network you use, your requirements and the
stability of your network.

Local Mode

In local mode, the connection to the PhonePad database is single-tier in nature.  Data is accessed via a
local or network file system.  This can be used for peer-to-peer and local area networks (LANs).  If you
have workstations on your network that crash on a regular basis then you may want to use remote mode
instead.

Advantages:

Simple to set up and administer.

Disadvantages:

If a computer crashes or is turned off with PhonePad running data may be corrupted, requiring a repair
of the database.
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Remote Mode

In remote mode you connect to the PhonePad data using a two-tier system (also known as client/
server).  PhonePad connects to the data via a server application and TCP/IP.  This can be used for peer-
to-peer networks, local area networks (LANs), wide area networks (WANs) and the Internet.

Advantages:

Computer crashes will not affect data integrity (unless the server crashes).
Connections can be across a network and/or the Internet.
PhonePad can be installed at home or in remote offices and still access the PhonePad data in your
office.

Disadvantages:

Requires a server application to be running on a computer on the network.
Slightly more complex to set up.

3.13 Creating a Phone Message

Please refer to Sending a Phone Message.

3.14 Creating a Text Message

Please refer to Sending a Text Message.

3.15 Customized Phone Message Labels

Many of the "labels" used in phone messages can now be customized using the Label Editor.  The
following labels can be changed:

While You Were Out
Phoned
Returned your call
Came to see you
No action required
Please phone
Will phone again
Will drop by again
Wants to see you
Will be in at
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The changes you make to the labels will appear in phone messages, phone message print outs, any
messages forwarded to email, and exported messages.  These changes are stored in a file called
LABELS.INI.  This file must be present in the PhonePad directory for the changes to take effect.  See
the separate Label Editor help for more information.

3.16 Deleting a Phone Message

Messages can be deleted from both the Inbox and  Sent Messageslists.  To delete a message, select it
and click on the Delete button on the sidebar.  You can also click on the Delete button on the toolbar, or
select Delete Message from the File menu, or simply press the Delete key on your computer keyboard.
Multiple phone messages can be deleted by selecting the messages while holding down the <ctrl> or
<shift> key.

To delete a phone message:

Click the Delete button on the toolbar.

Or click the Delete button on the sidebar.



Using PhonePad 63

Copyright © Cybercom Software

3.17 Dialing Phone Numbers

If a phone message contains the caller's phone number, PhonePad can dial the number for you.

To dial a number, select the appropriate message in the Inbox list and click the Dial button on the
toolbar (or select Dial Number from the File menu, or click the Dial button on the sidebar).

The Call Prompt dialog will be displayed.

Pick up the telephone receiver and then click the OK button.  Please note: if you click OK before
picking up the received, the call will be disconnected.

To dial a message's phone number:

Click the Dial button on the toolbar.

Or click the Dial button on the sidebar.

Notes:

You must have a modem connected to your computer to use this option.
You should check the settings under Preferences to ensure that you have the correct modem
settings.
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3.18 Distribution Groups

With Distribution Groups, you can set up lists of users that you frequently send phone and/or text
messages to.  Instead of selecting each user individually, you only need to select the group.  Each user
in the group will then receive the message.

Creating a Distribution Group

To create a new distribution group, click on the New button.  Enter the name of the group and click OK.

Renaming a Distribution Group
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Select the distribution group to rename and click the Edit button.  Change the name of the group and
click OK.

Deleting a Distribution Group

Select the distribution group to delete and click the Delete button.  You will be asked to confirm the
deletion.

Adding and Removing Users to a Distribution Group

Users are added to, and removed from, a distribution group using the following buttons:

Adds the selected users to the selected group.

Removes the selected users from the group.

Adds all users to the selected group.

Removes all users from the selected group.

Multiple users can be selected by holding down the <ctrl> or <shift> key when clicking on the names.

To open the Distribution Group window:

Click the Distribution Groups button on the toolbar.

Or click the Distribution Groups button on the sidebar.

3.19 Editing an Address Book Entry

Although PhonePad will automatically update entries in the Address Book, you can also edit them
manually.
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To edit an entry, click on the Edit button in the  Address Bookand change the appropriate details.  Click
OK to save the changes.

Buttons

OK Adds the new Address Book entry.

Cancel Cancels the additions you have made.

Print Prints the Address Book entry.

Import Imports a contact from Microsoft Outlook™.

Export Exports the Address Book entry to Microsoft Outlook™.

Settings Allows you to specify which fields to import from or export to Microsoft Outlook™.

Help Displays online help (which you are now viewing).
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Restrictions

Private If checked, this entry will only appear in your Address Book and will
not be displayed in the Caller drop-down list for other PhonePad users.

Updateable by Other Users If checked, other PhonePad users will be able to update the Address
Book entry (both automatically and manually).

If the following message is displayed when you attempt to edit an Address Book entry, this means that
the user who created the entry has decided to not allow other PhonePad users edit access.

To open the Address Book:

Click the Address Book  button on the toolbar.

Or click the Address Book  button on the sidebar.

3.20 Emailing Messages

Individual phone or text messages can be sent to an email address.  All you need to do is select the
message and then click on the Email Message button on the toolbar, or select Email Message from the
File menu.
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The Select Recipients list on the left side of the dialog displays all PhonePad users that have an email
address defined in the system.  If they don't have an email address they won't appear in the list.*

The message can be sent to as many email addresses as you like.  Just add them to the list on the
right by selecting them and clicking the right arrow button.  Email addresses can be removed from the
right-hand list by selecting them and clicking on the left arrow button.

Other email addresses can be added by entering them in the Enter an email address box and clicking
the right arrow button next to it.

You can also add attachments by clicking on the  button and selecting one or more attachments.

Use the  button to clear all attachments from the list.

Click the OK button to send the message.  

Please note that you will need to select the Email Method under Settings.  If you select SMTP then
you will need to specify your SMTP server settings and email account details.

* Users can add their email address to the system via the Message Forwarding dialog (the Send to
Email Address option does not have to be checked).

3.21 Exporting the Address Book

This option allows you to export your PhonePad Address Book to a text file, Microsoft Excel, Microsoft
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Word or HTML.  Just follow these steps:

1. Type in the name of the file to export to, or click the  button to select the appropriate directory
and enter a filename.

2. Select the fields you want to export by clicking in the checkbox next to each field name.

3. Select the Export Type.

4. Select the Field Delimiter to use to separate the data of each field (this only applies to text files).

4. Select the appropriate Text Qualifier option (this only applies to text files).

5. Click the Export button.

3.22 Exporting Messages to Text File

This option allows you to export your PhonePad messages to one or more text files.  The messages can



PhonePad Help70

Copyright © Cybercom Software

be either stored in one single text file, or individual files for each message.

To export messages:

1. In the Inbox, select the messages to export.

2. Select Export Messages to Text File from the Tools menu.

3. Enter the export directory, or click on the  button and select the appropriate directory.

4. Select either Single file or Individual files.

5. Click OK.

The name of the text files generated are in the following format (depending on your regional date format):

mmddyyyyx.txt

Eg.  022320020.txt, 022320021.txt, 022320022.txt.

3.23 Exporting Messages to CSV File

This option allows you to export your PhonePad messages to a comma delimited file for importing into a
spreadsheet application, eg. Microsoft Excel™.  The PhonePad message data is not entirely suited for
this purpose as the number of fields can vary between messages.  Therefore the import into your favorite
spreadsheet program won't be perfect.
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To export messages:

1. In the Inbox, select the messages to export.

2. Select Export Messages to CSV File from the Tools menu.

3. Enter the export directory and file, or click on the  button and specify a file.

4. Change the delimiter if required.

5. If Include Headings is checked, a heading for each field will be added to each message exported.

6. Click OK.

3.24 Exporting to Microsoft Outlook

This dialog allows you to export the current Address Book entry to Microsoft Outlook™.  You can either
create a new Microsoft Outlook™ contact or update an existing one.
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To update an existing Microsoft Outlook™ contact, you will need to select the contact from a list of

available contacts.  Click on the  button to select a contact using the Outlook Contact Lookup dialog.
 You can specify which contact fields to export to via the Outlook Import/Export Settings dialog, which is
available from the Address Book entry screen.

Export Exports the current Address Book entry to Microsoft Outlook™.

Exit Closes the dialog.

Help Displays online help.

3.25 Filtering Inbox Messages

You can filter the messages in the Inbox, showing only the messages you are interested in.  These can
also be sorted by clicking on the column headings.

To filter the messages, right-click on the Inbox heading and select a filter from the popup list.  It's that
simple.  A word of warning though: some of the filters will hide new messages you receive.  For
example, if you select Read Messages, new messages will not be displayed (even urgent ones).  So be
careful when using this filter that you remember to set it back to All Messages when you have finished.
Message filtering will default to new messages when you restart PhonePad (unless to change the default
setting under Preferences).
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3.26 Follow Ups

There are probably many times where receiving a phone message requires some type of follow up
action.  For example, you may need to return the call, collect some information for the caller, prepare
documents for sending, etc.  PhonePad has a number of features which make it easy to manage and
track follow up of messages.

These are the toolbar buttons for Follow Ups:

Marks a message for Follow Up.

Adds a Follow Up Note, which is displayed in the Follow Up Notes list.

Allows you to edit a Follow Up Note.  Notes can only be edited by the person that created
them.  Other users can only view them.

Deletes the selected Follow Up Note.  Notes can only be deleted by the person that
created them

View the selected Follow Up Note.

Marks a message as Completed.

3.26.1 Marking Messages for Follow Up

You can mark messages to be followed up so that you can easily identify them in your message lists.
 When you mark a message for follow up, an icon will be displayed next to the message in the Inbox or
personal folder.

To Mark a Message for Follow Up:

Select the message and click on the Follow Up button on the toolbar
. 
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If you want to cancel a follow up, just select the message and click the Follow Up button again. 

3.26.2 Follow Up Notes

Follow Up Notes make it easier for you to track the progress of follow on action that needs to be done. 
Each message can have an almost unlimited number of Follow Up Notes.

3.26.2.1 Follow Up Notes List

The Follow Up Notes list is positioned below the message list in your Inbox, Folders, etc.  When you
select a message, any Follow Up Notes it has will be displayed.

The list displays the date and time of each note, the note text, and the name of the user who created the
note.  Long notes will be clipped in the list.  In this case, you will need to open the note to view the
complete note.

The order the notes are displayed in is dependent on the message list's sort order. 

3.26.2.2 Adding a Follow Up Note

To add a Follow Up Note, select the message and then click the Add Follow Up Note button on the
toolbar.
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Click the Add Follow Up Note button on the toolbar. 

Enter text for the Follow Up Note.  You can change the date and time if required.  Click OK to save the
note.

The Stamp button inserts a date and time stamp.

3.26.2.3 Editing a Follow Up Note

To edit a Follow Up Note, select the message and then click the Edit Follow Up Note button on the
toolbar.

Click the Edit Follow Up Note button on the toolbar. 
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Edit the text of the Follow Up Note.  You can change the date and time if required.  Click OK to save the
note.

The Stamp button inserts a date and time stamp.

The Assign to Message ID allows you to reassign a follow up note to another message. Enter the
Message ID of the other message and click OK.

3.26.2.4 Deleting a Follow Up Note

To delete a Follow Up Note, select the message and then click the Delete Follow Up Note button on the
toolbar.

Click the Delete Follow Up Note button on the toolbar. 

3.26.2.5 Printing Follow Up Notes

To print the Follow Up Notes for a message, right-click on the Follow Up Notes list and select one of the
print options from the popup menu.

Print Message with Follow Up
Notes

Print both the selected message and its Follow Up Notes.
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Print Follow Up Notes Only Print only the Follow Up Notes for the selected message.

3.26.2.6 Default Follow Up Completion Text

If you don't want to enter the text for a Follow Up Note every time you mark a Follow Up Note as
completed, you can set PhonePad to automatically add some default text for you.  When this option is
enabled, PhonePad will create a Follow Up Note containing the default text when you click the Mark as
Completed button.

Click the Mark as Completed button to automatically create a Follow
Up Note with the default completion text.

3.26.3 Completing a Follow Up

Once you have completed a follow up, you can mark the message as completed.  An icon will be
displayed next to the message.

To Mark a Follow Up as Completed:

Select the message and click on the Mark as Completed button on
the toolbar.  You can also mark a message as completed without
marking it for follow up first.

You will be prompted to enter a Follow Up Note when completing a follow up, unless you have this option
disabled in Preferences.  In that case, a default completion message will be added to the Follow Up
Notes list.
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IMPORTANT INFORMATION

When a user marks a message as completed, it is only marked for that user.  Other users who received
the message won't have their messages marked as completed.  If you want to mark messages as
followed up for each user, you can set PhonePad to automatically mark them.  Refer to Preferences for
more information.

3.26.4 Cancelling a Follow Up

To cancel (or un-mark) a Follow Up, just select the message and click the Follow Up button again. 

Select the message and click on the Follow Up button on the toolbar
. 

3.27 Forwarding Messages

Phone and text messages can be forwarded to another person using the Forward option.

To Forward a Message to Another Person:

Click on the Forward button on the toolbar.
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Or click on the Forward button on the sidebar.

Fill in the message in the same way as you would with a normal text message. 

Phone messages are forwarded as attachments.  To view the attachment, the recipient simply double-
clicks on the icon that appears at the bottom of the message.

Forwarding a message should not be confused with Automatic Message Forwarding.

3.28 Import Template

To import files you need to specify how each field should be mapped.  The text file you are importing
from will contain a number of fields or columns.  The mapping feature allows you to specify which 
Address Book fields this data should be imported into.  The screenshot below shows a simple example.

Use the Add Field button to add fields.  Fields can be removed using the Delete Field button.



PhonePad Help80

Copyright © Cybercom Software

To map a field, click in the Address Book Fields area.  Select the Address Book field from the drop-
down list.

To avoid having to enter these field mappings in each time you need to import Address Book entries, you
can save the mappings to a file using the Save button.  Naturally, mapping files can be loaded using the
Load button.  There is no limit to the number of mappings files you can have, which means you can have
different mapping files for different data sources.

3.29 Importing Address Book Entries

Contacts can be imported from Comma Separated Value (CSV) files into the Address Book using the
Import facility.  To import data you will need to create at least one import template.

1. Open the Address Book and click the Import button.
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2. Type in the location and name of the import file to import from, or click on the  button and select
it from the dialog.

3. Select an Import Template.  If you don't have any defined you can create one by clicking on the Edit
Template button.  (See Import Template for more Information).

4. If the first line in the import file is a field header you can ignore it by checking the Ignore first line in
import file checkbox.

5. Select any Restrictions that may apply to the entries you are about to import.

6. Click the Import button.

Restrictions

Private If checked, this entry will only appear in your Address Book and will not be displayed in
the Caller drop-down list for other PhonePad users.

Updateable by If checked, other PhonePad users will be able to update the Address Book entry (both
automatically and manually).

3.30 Importing From Microsoft Outlook

This dialog allows you to import a Microsoft Outlook™ contact to the Address Book.  You will need to
select the contact from a list of available contacts.  

Click on the  button to select a contact using the  Outlook Contact Lookupdialog.  You can specify
which contact fields to import from via the Outlook Import/Export Settings dialog, which is available from



PhonePad Help82

Copyright © Cybercom Software

the Address Book entry screen.

Import Imports the selected Microsoft Outlook™ contact to the Address Book
.

Exit Closes the dialog.

Help Displays online help.

3.31 In-Out Board

The In-Out Board provides a simple way for an organization to keep track of their staff.  A quick glance at
the screen tells you the availability of everyone in your office.  Used in conjunction with PhonePad, you
can pass on information to callers while taking a message for the person they called.  For instance, you
can tell the caller that Mary is away today but she will get the message as soon as she gets back
tomorrow.
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Receptionists and Administrators can change the status of other users, while standard users can only
change their own status.  To change the status of a user (including yourself) simply select the name
from the list and click the appropriate button at the bottom of the In-Out Board window.

You can specify the time you will be back by clicking on the Back At button.  Click the Notes button to
provide further details about your unavailability.

In Changes your status to indicate that you are In.

Out Changes your status to indicate that you are Out.

Busy Changes your status to indicate that you are otherwise Busy.

Meeting Changes your status to indicate that you are in a Meeting.

Away Changes your status to indicate that you are Away from the office.

Back At Sets the time that you will be available again.

Notes Allows you to add a note for other users.  If you have setup
PhonePad to automatically update your status, this field will contain 
'Status set automatically'.

Forward Allows you to enable and disable Automatic Message Forwarding.

Refresh The status list is automatically updated every 60 seconds.  Click this
button to update the list immediately.
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The status list can be sorted by clicking on the column headings.  A sort arrow in the column heading
indicates the direction of the sort.  Also, the list can be manually sorted using drag n' drop.  Simply hold
down the <ctrl> key and drag the user using the left mouse button.  When it is in the position you want
just release the mouse button.  The In-Out Board will remember the sort order no matter which method
you use.

Under Preferences, there are options that can automatically set your status whenever the In-Out Board
starts up and closes down.

The In-Out Board is an add-on application for PhonePad.  It cannot be run as a separate application.

3.32 Installing Help Files Locally

In June 2005, Microsoft released Security Update 896358, which effectively disables all HTML Help files
located on network drives.  If you have PhonePad installed on a network drive then you will probably find
that your help files don't work - an example screenshot is shown below.

You can resolve this issue by installing the help files on your local hard drive.  This option is available
from the Help menu (it will be disabled if PhonePad is installed locally):
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When you select this option, the following window will be displayed.  To install the help files, click the 
Install button.  Once this has been done, when you select Help PhonePad will open the local help files
rather than the help files located on your network.

3.33 Licensing PhonePad

When you purchase PhonePad you will receive a serial number via email from sales@cybercom-
software.com.  If you have anti-spam software installed, please ensure that this email address is on
your White List.

There are two ways to license PhonePad:

Enter your serial number and email address, and download your license key from our license server.
Load the license key from a license key file you have received from us via email.

Retrieving Your License from the Internet

1. Run License.exe.

2. Enter your Serial Number.  You should have received this via email.

3. Enter the Email Address you used when you ordered PhonePad.

mailto:sales@cybercom-software.com.
mailto:sales@cybercom-software.com.
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4. Click the Request License Key button.

5. Your license key will be downloaded from the Internet.  Please be patient - this may take a few
minutes.

6. The details of your license key will be displayed under License Information.

7. Click the License button.

Retrieve Your License from a License Key File

1. Run License.exe.

2. Select the Retrieve License from File tab.

3. Select the License Key file.  It will be called PHONEPAD4.KEY, however, if you have upgraded from
PhonePad 3 then the file may be called PHONEPAD3.KEY.

4. Click the License Info button.

5. The details of your license key will be displayed under License Information.

6. Click the License button.
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3.34 Logging In

The login dialog is displayed when PhonePad starts up.  To login, you need a valid username and
password.  If you don't have one, ask your PhonePad Administrator to create one for you.

Please note that, although the user name is not case-sensitive, the password is.  If you have your caps
lock on, CAPS LOCK will appear in red  on the login dialog to warn you.  

Once you have typed in your user name and password, click OK to continue the login process.  You will
be given three attempts to login.  After a third unsuccessful attempt PhonePad will automatically shut
down.

The login dialog will display either (Local) or (Remote) in the title bar to let you know that you are
connecting to the PhonePad database in either Local Mode or Remote Mode.
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3.35 Message Archiving

Messages can be archived within PhonePad, although this can only be done by users with PhonePad
administrator rights.  You can archive messages from the Inbox, search screen, or personal folders.

Before archiving any messages you need to understand how messages work in PhonePad.  When you
receive a message in your Inbox you don't receive the real message.  The message is actually stored in
a separate part of the PhonePad database (the Messages table).  What you receive in the Inbox is a
"pointer" to the message.  When you select a message in the Inbox (or Sent folder, or personal folders),
the message is then retrieved from the Messages table.

There are a couple of reasons for this:

It's more efficient as only one message is sent, even if there are multiple recipients.  This helps keep
the database size down.
Messages can be shared, which means everyone who received the messages can see any notes
added or changes that are made.

You need to give some forethought to archiving messages, because once the message has been
archived, users will no longer have any access to them (unless you unarchive them).  The archiving
process not only moves the message to the message archive but it also removes the "pointers" from the
Inbox, Sent folder, and personal folders.  If it didn't do this users would get an error message because
the "pointers" would be pointing to a non-existent message.

To archive messages, select the appropriate messages in the message list and select Archive
Messages from the Tools menu.  You will be asked to confirm that you want to archive the messages.
You can also right-click on the message list and select Archive Messages from the popup list.
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3.36 Message Printing

Phone messages can be printed in the formats shown in this dialog.  As you select the different options
in the list, an explanation will be shown in the lower part of the window.  Select the most appropriate
option and click the Print button.  If you want to preview the messages before printing, click the Preview
button.
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Preview Displays the messages in a preview window before printing.

Print Prints the message without previewing it first.

Cancel Cancels printing.

Help Displays online help (which you are now viewing).

Printing Options

Standard Prints one message per page in a standard format, including
any follow up notes.  Ideal for messages that span multiple
pages.

Message Form -1 message to a
page

Prints one message to a page using a message type layout,
including any follow up notes.  Each message fills the page.

Message Form - 2 messages to
a page

Prints up to two messages to a page using a message type
layout.

Message Form - 4 messages to
a page

Prints up to four messages to a page using a message type
layout.

Print Follow Up Notes When checked, Follow Up Notes will be printed along with the
selected message/s.  Note that with some print options this
cannot be unchecked.
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3.37 Message Receipts

If you want to be notified when the recipients of a message have read it, check the Receipt box in phone
and/or text messages.

When the message has been read, a message receipt will appear in your Inbox.

Message receipts are just another form of text message, however, they cannot be edited.

3.38 Moving Messages

Messages can be moved from the Inbox to personal folders, or moved between personal folders by
selecting a message and then right-clicking on it.  A popup message will be displayed:
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Select Move to Folder.  You will be prompted to select the folder you want to move the message to:

Select the appropriate folder and click OK.  The message will then be moved to the selected folder.

3.39 Outlook Contact Lookup

The Outlook Contact Lookup dialog is used to lookup and select available contacts in Microsoft
Outlook™.
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Ok Click the OK button to import the selected contact.

Cancel Click the Cancel button to close the dialog.

Contacts Click the Contacts button to retrieve a list of all available contacts from
Microsoft Outlook™.  This can take a while depending on how many
contacts you have in Microsoft Outlook™.  The more contacts you
have the longer it will take.

Help Displays online help.

3.40 Outlook Import/Export Settings

This dialog allows you to specify which Microsoft Outlook™ contact fields to import from or export to. 
This is done by selecting a contact field from the drop-down list for each Address Book field.  For
example, by default the Address Book Address 1 field is linked to the Microsoft Outlook™ contact
BusinessAddressStreet field.  You can change this by selecting another field from the drop-down list.  In
the screenshot below we are changing it to MailingAddressStreet. 
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Ok Saves the changes you made to the field settings.

Cancel Cancels any changes you have made.

Help Displays online help.

3.41 Performance Issues

If you experience any performance issues when using PhonePad, please refer to this information.

Phone Messages

If you find that the phone message form is really slow to display when creating a new phone message,
the most likely cause is that your Address Book is growing fairly large.  When the phone message
window is displayed it has to load all of the caller information from the Address Book into the lookup
lists.  The more Address Book entries the longer it can take.  

Here are some things you can do to overcome this.  Try these in the order they are listed (all of these
options are under Preferences.

Turn off Sort 'From' List - If you're using the From lookup list the incremental search feature will still
allow you to easily find the right organization.
Turn off Load From Details - Unless you get a lot of callers from the same organization, you probably
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don't need the From lookup list.
Turn off Sort Caller List - Although a sorted caller lookup list is nice, you can still find callers easily
using the incremental search.
Turn off Load Caller Details - This is a last resort and you shouldn't need to do this.  In fact, if you get
to this point then please let us know.  

If speed issues occur when viewing a message, turn off Caller Details Editing unless you really need it.

Address Book

If you find that the Address Book window takes a long time to load then, again, you probably have a very
large Address Book.  Here are some things you can do to speed things up.  These options are under 
Preferences.

Make sure Buffer Address Book List is checked - This should make a huge difference.
Turn off the Show ALL Tab option - Only loading entries under each Index tab speeds things up.

3.42 Personal Folders

After a while, your Inbox may end up with a lot of messages in it.  PhonePad allows you to create your
own folders for storing messages you have received.

To create your own folders, click on the Folder Manager icon on the toolbar, or select Folder Manager
from the Tools menu.  The Folder Manager window will be displayed.  The folder list shows all of your
personal folders, the number of messages each one contains, and whether it is a public or private folder.
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Adding a New Folder

Click Add to create a new folder.  Enter a name.  If the Public Folder option is checked, other users will
be able to access the folder and its messages.  Click OK.

Editing a Folder

Click Edit to change the name of the selected folder.  Enter the new name.   If the Public Folder option
is checked, other users will be able to access the folder and its messages.  Click OK.

Deleting a Folder

Click Delete to delete the selected folder.  You will be prompted to confirm the deletion.  All messages
will be deleted.

Public Folders

Any of your personal folders can be made into public folders.  Simply click on the Public Folder option in
the edit window and other users will be able to access the messages in these folders.

Only folder owners and administrators can edit or delete public folders, or change their public folder
status.

See Moving Messages for information on how to move messages into your personal folders.

Messages can be sorted in personal folders by clicking on the column heading.
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3.43 Phone Number Formatting

Important Information About Phone Number Formatting

If you want to take advantage of the Caller Time Lookup feature, you have to 
format phone messages in a specific way:

(country code - area code) phone number

For example:

(1-219) 555 6789

The Country Code and Area Code must be separated by a hyphen and 
enclosed in brackets for the lookup feature to work.  

If you omit the Country Code, PhonePad will assume the Area Code is in your 
country (which it determines automatically from information it retrieves from the 
operating system).

3.44 PhonePad Shutdown

Sometimes the system administrator may need to shutdown PhonePad to perform routine maintenance.
 

If you are using PhonePad at the time, a message will be displayed advising you that PhonePad will be
shutting down in 5 minutes.  You would be well advised to finish sending any phone messages you are
composing and exit PhonePad.  Once the 5 minutes has expired, any users currently logged in to
PhonePad will be logged out automatically by the system.

If you try to run PhonePad and the following message is displayed, it means that PhonePad has been
shutdown and you will need to try again later.
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3.45 Preferences

The Preferences window allows you to customize PhonePad's settings.  It is divided into 11 tabs:

General

Messages - 1

Messages - 2

Messages - 3

Follow Up

Security

Address Book

Dates and Times

Dialing Setup

Time Zones

In-Out Board

To open the Preferences window:

Click the Preferences button on the toolbar.
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Or click the Preferences button on the sidebar.

3.45.1 Preferences - General

The General tab contains various options for customizing PhonePad settings.

Startup Options

Run from System Tray When checked, PhonePad will run as a system tray application.

Run Minimized When checked, PhonePad will minimize when it is started.
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Run on Startup When checked, PhonePad will start whenever Windows starts.

Application Settings

Application Minimizes
When Closed

When checked, clicking on the  button in the main window will
minimize PhonePad instead of shutting it down.  This is checked by
default.

Animated Hourglass 
Cursor

For something different, you can select this option to change the
standard hourglass cursor to an animated one.  Click the Test button
to see what it looks like.

System Tray Icon

Double Left Click Enables you to specify a default action when you double-click the
PhonePad icon in the system tray (note: the icon won't appear in the
system tray if the Run From System Tray icon is not enabled.

Available options are:

Open PhonePad
Create a New Phone Message
Create a New Text Message
Display Address Book

Toolbar Hints

Popup Hint Style Allows you to specify the style of popup hints used in PhonePad: 
Standard or Balloon.

Help Files

Location of Help Files By default, the help files for the PhonePad system are located in the
PhonePad directory.  However, due to a security update by Microsoft,
HTML Help files can't be displayed if they are located on network
drives.  This setting allow you to specify a local drive for the help files
(you need to install the help files on the local drive).

Notes

If you are upgrading from an earlier version of PhonePad, you may need to delete PhonePad from your
system's Startup group.
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3.45.2 Preferences - Messages

The Messages tab contains various options for customizing Message settings.

The Message Notification options can alert you whenever a new message arrives in your Inbox.  The way
the flash notification works depends on whether you are running PhonePad as a standard Windows
application or as a system tray application.  If you are running PhonePad as a standard Windows
application, the icon on the taskbar will flash until you restore the application window (ie. un-minimise it).
 If you are running PhonePad as a system tray application, the color of the PhonePad icon in the
system tray will cycle between blue, red and yellow.

The Notification Sound option allows you to specify a sound to play when new messages are received.
This is only enabled if the Beep When Messages Received option is enabled.  For more information,
refer to Using Notification Sounds.

Message Notification

Flash When Messages
Received *

PhonePad's icon on the taskbar flashes when a new message
is received in your Inbox.
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Flash Only When Urgent
Messages Received *

PhonePad's icon on the taskbar flashes only when a new
urgent message is received in your Inbox.

Do Not Flash Flashing is disabled.

Beep When Messages 
Received

A standard Windows beep will sound whenever a new message
is received in your Inbox.

Display Popup Messages Displays a popup message when a new message is received in
your Inbox.

Receive Other User 
Notifications

Applies only to Receptionist Mode.  Allows receptionists to
receive new message notifications for other users.

Switch to Inbox When checked, PhonePad automatically switches to the Inbox
when new messages are received.

Display Popup Balloon
in System Tray

When checked, a popup balloon will be displayed in the
system tray.

Display Alert Window in 
System Tray

When checked, an alert window will be displayed in the system
tray whenever new messages are received.

Notification Sound

Default Sound Plays the default Windows beep.

Sound File Instead of using the default Windows beep for alerting you
about new messages, you can play a WAV file.  Click on the 
button and select the WAV file to play.  8 sounds are included
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with PhonePad but you can add your own.

Click the sound button to preview the sound.

Inbox Message Filtering

Default Filter Specifies the default filtering to use for the Inbox.

* These options only work  when PhonePad is minimized and only when PhonePad isn't running as a
system tray application..

3.45.3 Preferences - Messages - 2

The Messages - 2 tab contains additional options for customizing Message settings.

Message Deletion

Confirm Message
D
e
l
e

If checked, you will be asked to confirm all message deletions.
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Confirm Message
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If checked, a message dialog will confirm a message has been deleted.

Default Message Action

Default Action Allows you to specify the default setting for phone messages.

Message Colors

Phone Messages Allows you to change the background color of phone messages.

Text Messages Allows you to change the background color of text messages.

Caller Details

Add Caller Details When selected, the From and Phone fields of a caller (that already exists in
the Address Book) will be automatically added.  Any details that have already
been entered in the From and/or Phone fields will be overwritten.

Protect Caller Details When selected, the From and Phone fields of a caller (that already exists in
the Address Book) will be automatically added.  However, any details that have
already been entered in the From and/or Phone fields will not be overwritten.

Clear Caller Details When checked, the From and Phone fields will be cleared if a new caller is
entered in the Caller field.

Auto Completion When checked, PhonePad automatically fills in the caller's organization and
phone number.

Load Caller Details When checked, the phone message form loads callers the Caller drop-down
selection list that allows you to select callers.  You would normally leave this
option checked if you want to be able to select callers.

Load From Details When checked, the phone message form loads a list of organizations from the
Address Book.  This can save time by allowing you to select a caller's
organization.  You may want to disable this option to improve performance if
you have a very large Address Book.

Sort Caller List When checked, the caller selection list will be alphabetically sorted.  With very
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large Address Books there can be a performance hit so if you find the phone
message form takes a long time to display then you may want to disable this
option.  Although this option can make it easier to find names the incremental
search feature will quickly filter out the other entries.

Sort From List This has similar functionality to the Sort Caller List setting.

Received Messages

Message Text Editing When checked, allows editing of the message area of received phone and text
messages.  Please note:  This setting has no affect on Message Receipts -
they cannot be edited.

Caller Details Editing When checked, allows editing of the caller details in a received phone
message.  This is useful when incorrect information has been entered, eg. the
telephone number.

Prompt to Save When
Changed

When checked, you will prompted to save any changes you have made to a
received phone or text message.

Auto-Display Messages When checked, messages are automatically display as they are received.

Message IDs

Show on Messages If checked, messages will display the Message ID when viewed*.

Show in Inbox, Sent and 
Folders

If checked, the Inbox, Sent and Folders lists will display the Message ID for
each message*.

Message Confirmation Dialogs

Show Sent Dialogs When checked, a message dialog will confirm that messages have been sent.

Show Confirmation on
C
a
n
c
e
l

When checked, a message dialog will confirm the cancellation of a message.

* You would not normally need to display the Message IDs, however, this feature exists in the event that
you need to be able to identify messages by their unique identifier.



PhonePad Help106

Copyright © Cybercom Software

3.45.4 Preferences - Messages - 3

The Messages - 3 tab contains additional options for customizing Message settings.

Default Telephone Message Font

Font Specifies the default font to be used in the message area in phone
messages.  This only applies to messages you create.

Size Specifies the size of the above font.

Default Text Message Font

Font Specifies the default font to be used in the message area in text
messages.  This only applies to messages you create.

Size Specifies the size of the above font.

Auto Address The auto address feature allows you to automatically add recipients to
new messages.  If you tend to send messages to the same recipients
all the time, this option can save you a bit of time by adding the
recipients for you.  Use the plus and minus buttons to add or remove
users to/from the list.

You can specify which type of messages the auto addressing feature
will adds users to by selecting the appropriate radio button under 
Applies To.



Using PhonePad 107

Copyright © Cybercom Software

Font Preview

Font Preview in Messages When checked, the font drop-down list will display a preview of the font
in a small window in both telephone and text messages.

Group Messages

Mark all messages as read When checked, a message will be marked as read in the Inbox of all
recipients when one of the recipients reads the message.

3.45.5 Preferences - Messages - 4

The Messages - 4 tab contains additional options for customizing Message settings.
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Phone Message Subject

Subject Prefix When checked and a prefix is specified, the subject field in new phone
messages will be automatically prefixed with the text you enter.

Use Message Details
When Subject is Blank

When checked, the subject field will contain message details if the Subject
field is left blank.  For example:  Phoned - Please Phone.

Prevent messages from
being sent if subject is
blank

When checked, messages cannot be sent if the Subject field is blank in a
telephone or text message.

Recipient List

Disable mouse in
Recipient List

When checked, the mouse cannot be used to select names in the Recipient
List in telephone messages.  This option is generally used to prevent
accidental selection of names when using the keyboard for recipient selection.

Spell Checking

Configuration Click this button to open the Spelling Options window. 

Inbox Message List Colors

This option allows you to set the color of messages as they appear in the Inbox message list.  By using
different colors, you can visually differentiate between message types.
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Unread Messages Messages that haven't been read yet, including new messages, will be
displayed in the message list using the selected color. This setting can be
overridden by the other settings below (ie. Urgent Messages, Private
Messages, Followup Messages and Group Messages).  The default is blue.

Urgent Messages 1 Urgent messages will be displayed in the selected color.  The default is red.

Read Messages Messages that have been read will be displayed in the selected color.  The
default is black.

Private Messages 1 Messages that are marked as Private will be displayed in the selected color. 
The default is Green.

Followup Messages 2 Messages that are marked for follow up will be displayed in the selected color.
The default is Fuchsia.

Group Messages 1 Group messages are messages that are sent to more than one person.  These
messages will be displayed in the selected color.  The default is Purple.

Message Lists

Select Latest Message When checked, the Inbox message list will always scroll to the latest
message when new messages are received.

Message Sorting This option allows you to specify the sort order of all message lists in
PhonePad, including the Follow Up Notes list.  You can set this option to
either display the newest messages at the bottom of the list or the top.

Notes

1 Affects only unread messages.  Read messages will appear in the Read Messages color.

2 Affects only read messages.  Also requires the Change read message color only when follow up
has been completed option to be checked (under Follow Up Preferences).

3.45.6 Preferences - Messages - 5

The Messages - 5 tab contains additional options for customizing Message settings.
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Read Messages

Move Read Messages to
This Folder

When checked, messages will be automatically moved to the specified folder
after it has been read.

3.45.7 Preferences - Follow Up

The Follow Up tab contains options for customizing message Follow Up settings.
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Follow Ups

Automatically mark  all new
phone messages for follow up

When checked, new phone messages that are received will be
automatically marked for follow up.

Show follow ups on startup When checked, the Inbox will show display all messages that
need to be followed up.  See Filtering Inbox Messages for more
information.

Set messages as completed for
all recipients

When checked, a message will be marked as completed in the
Inbox of all recipients.

Change read message
color only when follow up 
has been completed

Normally, the color of a message will change in the Inbox
message list when the message has been read.  If  this option
is checked, the color will only change when the message has
been followed up.

Follow Up Completion Options

Display Follow Up Notes window
on completion

When checked, whenever you mark a Follow Up as completed,
you will be prompted to enter a Follow Up Note.

If unchecked, a default Follow Up Note will be created (see
following option).

Default Completion Text to
Display

If the above option is not checked, the text specified for this
option will be used for the default Follow Up Note that is
automatically created when a Follow Up is completed.
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Allow Completion Without Being
Marked for Follow Up

When checked, a message not marked for Follow Up can still
be marked as Completed.

When unchecked, only messages marked for Follow Up can be
marked as Completed.  This avoids accidentally marking a
message as Completed when really what you wanted to do is
mark it for Follow Up.

3.45.8 Preferences - Security

The Security tab contains various options for customizing PhonePad's Security settings.

Login

Standard Login Displays a login dialog box, prompting you for your Username
and Password.

Autologin Automatically logs you in using your last known Username
and Password.  No login dialog is displayed.

Remember User Name Displays a login dialog box as with a Standard Login, but it
remembers your Username for you.

Remember Username and Password This is similar to the above option but it also remembers your
Password as well.  This could be considered a security breach
in your workplace as it can provide unauthorized persons with



Using PhonePad 113

Copyright © Cybercom Software

access to your PhonePad data.  It is recommended that you
do not use this login mode.

You are given 3 attempts to login.  If you do not enter the correct Username and Password combination,
after 3 attempts, PhonePad will shutdown and you will need to run it again.

There is also a 5th login mode, which can only be setup by a system administrator.  This login mode
uses your Windows Username to log you in.  If the above options are all disabled then your system
administrator has invoked this option - you cannot override this.

3.45.9 Preferences - Address Book

The Address Book  tab contains various options for customizing the Address Book.

Adding and Updating

Add New Callers to Address Book If checked, automatically adds new callers to the Address
Book.

Update Address Book If checked, automatically updates existing Address Book
entries.

Prompt When Adding Callers If checked, prompts you before adding new callers to the
Address Book.  Only valid if Add New Callers to Address Book
is enabled.
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Prompt When Updating Callers If checked, prompts you before updating existing callers in the
Address Book.

Phone Number Updating

Automatically Update Field When selected, automatically updates the specified field in the
Address Book whenever the phone field is changed in a phone
message.  You can set it to update the Telephone, Alt. Phone,
Fax, or Cell/Mobile field.

Prompt Field to Update When selected, prompts for the appropriate field to update in
the Address Book.

Default Entry Permissions

Private If checked, new Address Book entries will be Private (ie. they
won't appear to other users in their Address Book or when
creating new messages).

Updateable by Other Users If checked, new Address Book entries can be updated by other
users (you can always update your own  Address Book
entries).

Address Book List

Buffer Address Book List When checked, the Address Book list only loads a limited
number of entries.  The reason for this is to conserve system
resources and improve performance.  When you scroll through
the list, entries will be automatically loaded and displayed with
very little lag, if any.

One downside to this is that the vertical scroll bar's thumb
button will not scroll entries until you release it.  If you prefer
the list to scroll as you move the thumb button then you can
uncheck this option.  But be warned: if you have a large
Address Book this can dramatically slow down the initial
Address Book window loading.

Show ALL Tab When checked, the ALL tab will be displayed, allowing you to
view all Address Book entries at once. Uncheck this option to
improve performance if you have a large Address Book.

Show Lines When checked, the Address Book list will display horizontal
lines
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3.45.10 Preferences - Dates and Times

The Dates and Times tab contains various options for customizing the format of dates and times in
PhonePad.  By default, PhonePad will use the settings as specified under the Windows Control Panel.
However, this tab allows you to change the formats used (this does not change the Control Panel
settings and so will not affect any other applications).

Inbox and Sent Messages Lists

Date Format Specifies the format of the date displayed in the Inbox and Sent Messages list

Time Format Specifies the format of the time displayed in the Inbox and Sent Messages list

Sample Displays a sample of the current date and time, based on the settings for the Date
Format and Time Format.  This allows you to preview the settings you make before
saving them.

Status Bar

Date Format Specifies the format of the date displayed in the Status Bar clock.

Time Format Specifies the format of the time displayed in the Status Bar clock.

Sample Displays a sample of the current date and time, based on the settings for the Date
Format and Time Format.  This allows you to preview the settings you make before
saving them.
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Format Specifiers

It is recommended you only use the following format specifiers when specifying date and time formats. 
Using anything else may produce unusual results.

Date Specifiers

d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat).
dddd Displays the day as a full name (Sunday-Saturday).
m Displays the month as a number without a leading zero (1-12).
mm Displays the month as a number with a leading zero (01-12).
mmm Displays the month as an abbreviation (Jan-Dec).
mmmm Displays the month as a full name (January-December).
yy Displays the year as a two-digit number (00-99).
yyyy Displays the year as a four-digit number (0000-9999).
/ Date separator.

Time Specifiers

h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
m Displays the minute without a leading zero (0-59).
mm Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
am/pm Displays the time in 12 hour format with an am or pm.
: Time separator.

3.45.11 Preferences - Telephone Setup

The Telephone Setup tab contains options for configuring PhonePad's Caller ID and dialling features.
These settings are only valid if you have a TAPI device connected to your computer and telephone.
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Caller ID

Caller ID Enabled When checked, PhonePad will retrieve Caller ID information when you TAPI
connected telephone rings.

Display Caller
I
n
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When checked, PhonePad will display a pop window containing the phone number of
the caller.  If the caller already exists in the PhonePad Address Book, other caller
details will also be displayed.

TAPI Device Displays the selected TAPI device on your system.  If this is blank, the Caller ID
functionality will not work - click the phone icon to select a device.

Phone Dialing

Use TAPI Dialing When selected, PhonePad will dial phone numbers using the Windows TAPI
functionality.

Use Direct Modem
D
i

When selected, PhonePad will send commands directly to the modem to dial phone
numbers.
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3.45.12 Preferences - Time Zones

The Time Zones tab contains various options for customizing the format of dates and times shown in
the Caller Time Lookup feature.

Caller Time Information

Date Format Specifies the format of the date displayed in the Inbox and Sent Messages list

Time Format Specifies the format of the time displayed in the Inbox and Sent Messages list

Sample Displays a sample of the current date and time, based on the settings for the Date
Format and Time Format.  This allows you to preview the settings you make before
saving them.

Format Specifiers
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It is recommended you only use the following format specifiers when specifying date and time formats. 
Using anything else may produce unusual results.

Date Specifiers

d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat).
dddd Displays the day as a full name (Sunday-Saturday).
m Displays the month as a number without a leading zero (1-12).
mm Displays the month as a number with a leading zero (01-12).
mmm Displays the month as an abbreviation (Jan-Dec).
mmmm Displays the month as a full name (January-December).
yy Displays the year as a two-digit number (00-99).
yyyy Displays the year as a four-digit number (0000-9999).
/ Date separator.

Time Specifiers

h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
m Displays the minute without a leading zero (0-59).
mm Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
am/pm Displays the time in 12 hour format with an am or pm.
: Time separator.

3.45.13 Preferences - In-Out Board

The In-Out Board tab contains options for customizing the In-Out Board facility.
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Startup Options

Start When PhonePad
Starts

When checked, the In-Out Board will automatically start whenever
PhonePad starts.  If the In-Out Board is already running it will be
displayed.

Close When PhonePad
Closes

When checked, the In-Out Board will automatically close when
PhonePad is closed.

Start Minimized When checked, the In-Out Board will start automatically.

Run from System Tray When checked, the In-Out Board will run from the system tray.

Status Options

Set My Status as IN on
Startup of

You can have the In-Out Board automatically set your availability as 
In whenever it starts up by checking this option.  You can configure
this to occur on startup of either PhonePad or In-Out Board.

Set My Status as OUT
on Startup of

You can have the In-Out Board automatically set your availability as 
Out whenever it starts up by checking this option.  You can configure
this to occur on closing of either PhonePad or In-Out Board.
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Notes

If the In-Out Board is already running, you do not need to restart it for the changes to take effect.  The
changes will become effective immediately.
These settings can also be changed within the In-Out Board.

3.45.14 Preferences - Email

The Email tab allows you to specify which method you want to use to email messages from within
PhonePad.

Email Method

MAPI When selected, PhonePad uses the Windows Simple Messaging API (MAPI) to
send messages with the Email Message feature.

SMTP When selected, PhonePad uses a mail server to send messages with the Email
Message feature.  If you select this option you will need to configure your mail
server setttings under SMTP Settings.

        

SMTP Settings

Mail Server

SMTP Server This is the name of your mail server, eg. mail.xyzcorp.com.

SMTP Port This is the port number your mail server expects you to use.  The default is 25.

        

Email Account

Name (From) This is the name for the email address, eg. John Smith.
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Email Address This is the email address for the account you are using, eg. john@xyzcorp.com.

Username This is the username for the email account eg. john+xyzcorp.com or
john@xyzcorp.com.

Password This is the password for the email account you are using.

        

Authentication

Different mail servers require different authentication methods.  You may need to experiment with
different settings to determine what your mail server requires to authenticate a connection.  If you have
difficulties with this, Cybercom Software Support can assist with this.

Use SASL Use Secure Password Authentication methods (SASL) when connecting to the
mail server.

Use SASL Only Only use the only Secure Password Authentication methods (SASL) when
connecting to the mail server.

Use EHLO Use SMTP extensions when communicating with the mail server.

Use TLS Configures PhonePad to use the TLS 1.0 security protocol.
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Use SSL 2 Configures PhonePad to use the SSL 2.0 security protocol.

Use SSL 3 Configures PhonePad to use the SSL 3.0 security protocol.

Automatic The appropriate option will be automatically selected.

Implicit SSL negotiation will commence immediately after the connection is established.

Explicit PhonePad will first connect in plaintext and then explicity start SSL negotiation
through a protocol command such as STARTTLS.

None No SSL negotiation or security. All communication will be in plaintext mode.

         

Testing the Authentication Settings

You can test the settings by selecting the Mail Server tab and clicking the Test button.

Here is an example of a successful test.  The mail server has accepted the connection and sends a test
email.
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3.46 Print Preview

The Print Preview screen features a message preview area and a toolbar along the top of the screen.

Prints the contents of the preview.

Opens a saved preview.

Saves the preview to a file.

Exports the preview to PDF, RTF or HTML.

Finds text in the preview.

Displays the whole page on the screen.

Fits the preview to page width.

Displays the preview at 100%.

Displays the preview as two pages to a screen.

Allows you to select the zoom view for the preview.
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Allows you to change the page orientation and margins

The grab tool allows you to grab the pages and move them 
around.

The zoom tool allows you to vary the zoom view.

Navigation buttons allow you to navigate through multi-page
previews.

Closes the preview.

3.47 Printing a Phone Message

If you would like a hard copy of a phone or text message you have received, select a message in the 
Inbox or Sent Messages list and click on the Print button on the sidebar (you can also click on the Print
button on the toolbar, or select Print from the File menu).  Multiple messages can be printed by
selecting the messages while holding down the <ctrl> or <shift> key.  However, you cannot print a
mixture of messages - they either have to be all phone or all text messages.

To print a phone message:

Click the Print button on the toolbar.

Or click the Print button on the sidebar.

3.48 Quick Phone and Text Messages

If PhonePad is set to run from the system tray, you can quickly create a phone or text message without
the need to open PhonePad's main window.  Simply right-click on the PhonePad icon in the system tray
and select either New Phone Message or New Text Message from the popup menu
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3.49 Received Calls

The Received Calls screen displays all calls you have received, including missed calls.

You can access it by selecting Received Calls from the Tools menu.

Message Opens a new phone message and pre-fills the caller details.

Dial Dials the phone number for the selected caller.

Clear Clears all entries from the Received Calls list.

Close Closes this window.

Help Displays online help.
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Important Note:  The Received Calls features requires the Caller ID feature to be enabled.  For
Caller ID to work, you must have a TAPI compliant device (eg. a TAPI modem) connected to your
computer and a telephone.

3.50 Receptionist Mode

If you have been specified as a Receptionist, you will be able to check the Inboxes of other users.  This
is designed for offices where the receptionist takes messages for other staff, and then gives them their
messages when they return.  It can also be used for offices where the other staff don't have computers,
or the computers aren't connected to a network.

In Receptionist mode, a user list appears to the left of the Inbox message list.  Clicking on a name in the
user list will display the Inbox of that user, and their name will appear on the Inbox title bar.  You can
hide and unhide the user list by clicking on the Hotspot Button.

The Receptionist mode allows you to view, print and delete messages in any user's Inbox.  However, it
has no effect on the Sent Folder.  You can only view your own Sent Folder.

Before you can view the Inboxes of other users, you need to be given
access by the PhonePad Administrator.
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3.51 Replying to Messages

If someone sends you a phone or text message, you can reply to it.  The reply will be in the form of a 
text message.

To Reply to a Message:

Click on the Reply button on the toolbar.

Or click on the Reply button on the sidebar.

Fill in the message in the same way you would fill in a normal text message.  The recipient field will be
automatically filled for you.

3.52 Resending Messages

There may be times when you need to resend a message to someone - for example, if the recipient
accidentally deletes the message.  Any messages that you have sent can be resent to the same person
(as long as the message still exists in the Sent Folder).  

To resend a message, go to the Sent Folder list and select the appropriate message.  Next, click on
the Resend button on the toolbar (or click on the Resend button in the Sidebar, or select Resend
Message from the File menu).

To resend a message:

Click the Resend button on the toolbar.
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Or click the Resend button on the sidebar.

3.53 Searching

The Search option allows you to search for messages for which you are the recipient.  These messages
can be located in your Inbox, Sent folder or personal folders.

To search for a message, click on the  button on the toolbar, or select Search from the Tools menu.
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Enter the search text in the Search For field, select the search option from the Search In drop-down list
box, and click the Search button.

Message Sorting

Messages can be sorted by clicking on the column heading.

Popup Menu

The Search message list has its own popup menu, which can be accessed by right-clicking on the
message list.

3.54 Selecting Phone Numbers

This popup window allows you to select the appropriate phone number for the caller.  Select the number
and click OK.
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Numbers can also be added and/or edited in this window.  To edit a number, select the number field and
press F2, or double-click the field.  You can edit as many numbers as you like - any numbers you edit
will be updated when you click the OK button.

3.55 Selecting Recipients

There are two ways for selecting recipients of a message.

Recipient Lookup List

Pressing any key (eg. the <space> bar or a letter key) in the To box displays the Recipient Lookup List.
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This list provides an incremental search lookup facility for selecting recipients names quickly and easily.
 As you type in letters the list will narrow the search to the names that match.  You can also use the <

> and < > keys to navigate through the list.  Press the <enter> key to select a name.  Pressing
<esc> closes the list.

Recipient Lookup Window

Recipients of a message are selected by clicking on a new messages' To button.  Place a check mark
next to the name of each person you want to receive the message.
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If Distribution Groups have been setup, you can select one or more groups of people rather than the
individual names.  Just click on the Groups tab and select the relevant group/s.  You can view the
members of a group by clicking on the  button for the group.

Click OK when you have selected all of the recipients.

This button selects all users in the recipients list or all users in all
distribution groups.
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This button unselects all users in the recipients list or all users in all
distribution groups.

This button expands all distribution groups, showing the users of
each group.

This button closes all distribution groups, hiding the users of each
group.

3.56 Sending a Phone Message

Sending a phone message with PhonePad is easy:  

1. Click on the New Phone Message button on the sidebar, or click on the New Phone Message button
on the toolbar, or select New Phone Message from the File menu, or simply press the Insert key on
your computer keyboard.

2. The date and time of the message are automatically filled in for you, but you can change them if
you wish.  

3. Click on the user lookup button (To) and select one or more recipients from the list.  Alternatively,
click in the TO box and press any key to display a popup list of recipients.

4. Select a Caller from the drop-down list or type one in.  If the caller already exists in the PhonePad
Address Book, their details will be displayed automatically for you (if you have the Auto Completion
option enabled).  Alternatively, you can click on the Caller button to display the Caller Lookup
window.

5. Enter where the person is From, if applicable.  This is a drop-down list so you can select from a list
of organizations.

6. Enter a Phone No. for the caller, or click on the  button and select a phone number from the list.
(Click here for important information about phone number formatting). 

7. Select the appropriate details of the call, ie. Phoned, Returned Your Call or Came to See You.
8. Select an action for the recipient, ie. No Action Required, Please Phone, Will Phone Again, Will

Drop by Again, Wants to See You.
9. If required, enter a time for Will Be In At.
10. Click the Urgent box if the message is urgent.
11. Click the Private box if you don't want receptionists to be able to read the message.
12. Click the Receipt box if you want to be notified when the message has been read.  Important Note:

you will receive a receipt from every person in the To box.
13. Enter a Message if required.  You can use the formatting tools on the toolbar for this if you want to

change the font, style, etc.
14. Click the OK button to send the message.
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This may seem like a lot of steps to take but they are all fairly straight forward and can be performed
very quickly.

Selecting a Caller from the Drop-Down List

When the cursor enters the Caller field, the Caller drop-down list will be automatically displayed.  This
allows you to incrementally search through all callers in your Address Book.  A caller can be selected
by using the up and down arrow keys and then pressing the <enter> key or space bar.
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There is a similar feature for the From field (if enabled under Preferences).

The Message Text Area

The Message text area can display "Rich Text", which means you can apply various formatting to the
text you enter.  It has the following features:

Variable font type, style, color, size, etc.
Different text alignment for each line of text.
Cut, copy and paste.  Paste from another application, eg. Microsoft Word.
Right-click for a popup menu.

The Stamp menu option allows you to add a date and time stamp and username stamp.

The Message text area allows tabs for formatting messages.  Use <ctrl> <tab> to tab out of the
message area.

If the Add New Callers to Address Book  option is enabled under Preferences, any new callers you enter
will be stored in the Address Book (including where they are from and their phone no.).
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If the Update Address Book  option is enabled under Preferences, any changes you make to an existing
caller (ie. where they are from and their phone no.) will be updated in the Address Book.

Press F5 to go directly to the Message area.

3.57 Sending a Text Message

Sending a text message with PhonePad is easy:  

1. Click on the New Message button on the sidebar, or click on the New Message button on the toolbar
, or select New Message from the File menu, or simply press the Insert key on your computer
keyboard.

2. Select Text Message from the dialog.
3. The date and time of the message are automatically filled in for you, however you can change them

if you wish.  
4. Click on the user lookup button (To) and select one or more recipients from the list.  Alternatively,

click in the TO box and press any key to display a popup list of recipients.
5. Enter a Subject for the message..
6. Click the Urgent box if the message is urgent.
7. Click the Private box if you don't want receptionists to be able to read the message. 
8. Click the Receipt box if you want to be notified when the message has been read.  Important Note:

you will receive a receipt from every person in the To box.
9. Enter a message in the space provided.
10. Click the OK button to send the message.



PhonePad Help138

Copyright © Cybercom Software

Press F5 to go directly to the Message area.

3.58 Setting Up a Workstation for Local Mode

These instructions only apply if you have PhonePad physically installed on a workstation.

1. Once PhonePad has been installed, run DBConnect.

2. Under the Connection tab, select Local Mode.
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3. Under Local Database Directory, enter or select the location of your PhonePad data directory.  This
would normally be a shared folder on a network drive, or in the case of peer-to-peer networks, a
shared folder on the "host" computer.

4. If you like, you can use the UNC button to convert the path to a UNC path.

5. Click the OK button.

3.59 Setting Up a Workstation for Remote Mode

These instructions only apply if you have PhonePad physically installed on a workstation.
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1. Once PhonePad has been installed, run DBConnect.

2. Under the Connection tab, select Remote Mode.

3. Click on the Remote Settings button.

4. If you are connecting across a LAN, select 0 for Data Compression.  If you are connecting across the
Internet, select 6.
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5. Under Data Encryption, check the Encrypt data to/from server option if you are connecting across the
Internet.  Otherwise, leave it unchecked.

6. Click OK.

7. Select the Server tab.

8. Click on the Listen for IP Announcement button so that it is depressed.  Make sure that the
PhonePad Server (DBServer) has it's Announce option on*.

9. Within 15 seconds, DBConnect should receive a broadcasted announcement* from DBServer.  The 
Server IP, and Admin and Main ports fields will be filled in automatically and the Listen for IP
Announcement button will unselect itself.

10.Test the connection with DBServer by clicking the Test Server button.

11.Click the OK button.

* For this feature to work, any routers or bridges on your network must be configured to allow UDP
connections on port 12500.
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3.60 Spell Checking

The message areas of phone and text messages feature a built-in spell checker.  You have the option of
performing a  spell checkafter typing your message, or using live spell checking which highlights
misspelt words as you type them.

Before you can begin spell checking you need to configure the spell checking options.

3.61 Spelling Options

To configure the spell checker, select Preferences from the Tools menu, select Messages-4, and then
click the Configuration button under Spell Check ing.

The Spelling Options window allows you to select various spell checking options.

Options

Check spelling as you
type

When checked, Live Spelling is enabled.  Misspelt words will be automatically
highlighted with a red "wiggly" underline.

Correct spelling errors asWhen checked, the AutoCorrect option is enabled.  Misspelt words will be
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you type automatically corrected for you.

Ignore words in
uppercase

When checked, uppercase words will not be checked for correct spelling.

Ignore words containing
numbers

When checked, words containing numbers will not be checked for correct
spelling.

Suggest from main
dictionaries only

When checked, spelling suggestions will only be sourced from main
dictionaries.

Prompt on repeated wordWhen checked, you will be prompted where words are repeated.

Automatically correct
DUal capitals

When checked, words containing dual capitals will be corrected.

Dictionaries

Dictionaries PhonePad comes standard with a number of dictionaries for different
languages.  Dictionaries are stored in the Dictionaries sub-folder.  Select the
dictionaries you wish to you by checking the appropriate check boxes.

Custom Dictionary The custom dictionary is where new words are added.  This will be
automatically created for you, although you can create your own custom
dictionaries.

3.62 Spell Checking a Message

Live Spelling

If you have Live Spelling enabled, misspelt words will be automatically underlined in red. 
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To correct a possibly misspelt word, right-click on the highlighted word and select the correct suggestion
from the popup menu.  If the word is actually correctly spelt, you can choose to ignore it or add it to your
custom dictionary.

Ignore Ignore this occurrence of the word.

Ignore All Ignore all occurrences of this word.

Add Add this word to the dictionary.
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Change All Change all occurrences of the word.

Auto Correct If you select the corrected word from this list, the misspelt word will be added
to the Auto Correct dictionary.  Next time you misspell the word the same way,
it will be automatically corrected for you.

Spelling Displays the Spelling Options dialog, allowing you to specify the various spell
checking options.

Performing a Spell Check Manually

To perform a manual spell check, click on the Spell Check button on the toolbar.  

The Spelling dialog will be displayed, listing all the suggestions for the misspelt word.

The options shown in this dialog are the same as the Live Spelling options.

3.63 System Information

The System Information window displays important details about the PhonePad system.
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User Name: This is the login name you are currently logged in as.

PhonePad Version This is the full build no. for the version of PhonePad you are running.

Database Engine Version This is the version of the internal PhonePad database engine.

Data Directory If you are connected in Local Mode, the name of the data directory
will be displayed here.

Connection Mode This indicates which connection mode PhonePad is currently
configured to use: Local, Remote - LAN, or Remote - WAN/Internet.

Remote Data Directory If you are connected in Remote Mode, the location of the data on the
remote server will be shown.

Server IP Displays the IP address for the PhonePad server.  This only applies if
you are connecting in Remote Mode.

Server Port Displays the port for the PhonePad server.  This only applies if you
are connecting in Remote Mode.

License Name Displays the name of the organization PhonePad is licensed to.

Licensed Users Indicates the no. of users your PhonePad license covers.

License Expiry Indicates the date your license expires.  This only applies to
temporary licenses.  If you purchased a PhonePad license then you
have a permanent license.
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3.64 Using Notification Sounds

PhonePad can alert you audibly when a new message is received.  Although you will probably be away
from your desk when a phone message is taken for you, it can be used to alert you if a receptionist is
taking all messages for you or you are somewhere nearby when a message arrives.

Under Preferences, there is an option called Notification Sound.  This option gives you two choices:
Default Sound (which is the standard Windows beep) or Sound File.  The second option allows you to
specify a sound file (WAV) to play whenever a message is received.

Click on the  button to select a sound file.  A dialog will appear, allowing you to select a wav file on
your system.  PhonePad comes with 8 sounds you can choose from, or you can add your own sounds.
You can use anything from beeps to music.

Click on the  button to listen to the sound you have selected.

The notification sound will only be played if it can be found on your system.  If PhonePad cannot play
the sound because the wav file has been deleted or moved, the default Windows beep will be played
instead.

Please note that the Beep When Messages Received option must be checked for the sounds to be
played.

3.65 Viewing a Phone Message

Like all of the features in PhonePad, viewing a message is as simple as point-and-click.  You can view a
message using a number of methods:

Double-click on the message
Click on the View button on the Sidebar
Click on the View button on the Toolbar
Select View Message from the File menu
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The message has an appearance similar to that of the old paper-based message pads.

The  icon next to the caller's name activates the  Caller Time Lookupfeature.

To view a phone message:

Click the View button on the toolbar.

Or click the View button on the sidebar.

Notes

You can edit the message text of a phone message after you have received it.  This allows you to add
follow up notes and other information.  If you make changes to the text you will be prompted to save
them.
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3.66 What's Included with PhonePad

The PhonePad system consists of the following applications:

This is the PhonePad application.

This utility is used by an administrator to manage the
PhonePad system.

This utility is used to specify the location of the PhonePad
database.  It is also used to setup Local and Remote modes,
and to configure the PhonePad server.

This is a utility used by the administrator to update the
PhonePad database.

This is the PhonePad server application used for remote mode
connectivity.

This utility is used by an administrator to backup the
PhonePad database.

This utility is used to repair and optimize the PhonePad
database.

MessageSender provides the message forwarding capability. 
Like DBServer, it must be run on a computer on the network.

ServerManager New utility allows configuration and
management of remote connections and the PhonePad server.

This utility is used to customize the labels used within phone
messages.
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This utility is used to license your copy of PhonePad.

This utility makes it easy to create shortcuts on your desktop
when you install PhonePad in a shared folder.

The In-Out Board allows you to keep track of your staff.

4 Information

4.1 Contact Us

Contacting Us By Email

We provide unlimited FREE support via email.  For support with PhonePad or any of our other products,
please email us at:

support@cybercom-software.com

If you would like more information about PhonePad or any of our other products, or if you would like to
talk to us about ordering, please email us at:

sales@cybercom-software.com

We are dedicated to giving you the very best quality software possible, and we are always looking for
ways we can improve our products.  If you have any suggestions on how we can make our software
better, or new features we can add, please drop us a line at either of the above email addresses.

Contacting Us By Postal Mail

You can contact us by normal mail at:

Cybercom Software
PO Box 5006
Chisholm  ACT  2905
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Australia

World Wide Web

Visit our Home Page for information on all of our products, downloadable evaluation versions and the
latest upgrades.  There is even some free stuff you are welcome to download.  Enter the following URL
into your web browser:

www.cybercom-software.com

Contacting Us By Telephone

Our preferred method of support is via email, and you will receive the fastest response using this
method.  However, if you do not have email access you can phone us as detailed below.  Please bear in
mind that we are usually extremely busy on software development so you may have to speak with our
voicemail service.  If you leave a message, we will try to return your call as soon as possible.  Please
take note of the time difference if you are calling from overseas.

From within Australia: (02) 6291 9246
International: (+61-2) 6291 9246

You can reach us from Monday to Friday between 8:00 am and 6:00pm AEST (Australian Eastern
Standard Time).  We are +10 hours GMT.

4.2 Evaluation

Under the terms of the License Agreement, you are permitted to try PhonePad for 60 days from the date
of installation.  This is a once-only evaluation period.  After that date, you will not be able to continue
using PhonePad unless you purchase a license from Cybercom Software or an authorized reseller.  For
information on ordering, please refer to our web site at www.cybercom-software.com.

There are no limitations or restrictions in the evaluation version of PhonePad, apart from the 60 day limit.
 During the evaluation period, the following window will be displayed each time you start PhonePad.
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Click the Evaluate button to continue evaluating the software.  Once the evaluation
period has finished, the Evaluate button will be disabled thereby ending the free trial.
 To continue using PhonePad after this date you will need to purchase a license. 
You won't need to re-enter any data.  Once you have been issued with a license key
you will be able to continue from where you left off.  

If you need an extension to the evaluation period, please let us know and we will
extend it for you.  If you are just starting your evaluation of PhonePad and the 
Evaluate button is incorrectly disabled, please contact us and we will send you a
temporary license key.

Click the Order button to order PhonePad online.  Make sure you have an active
Internet connection.  Your browser will take you to the PhonePad order page on our
website, where you can order PhonePad online using a credit card via a secure
connection.  Once the order has been completed you will automatically receive your
license key via email.

For other order methods go to www.cybercom-software.com/order.htm.

If you have purchased PhonePad through a reseller (eg. Digital River or an online
retailer), you will need to register your copy of PhonePad to receive your license
key.  The reseller will supply you with a serial number for this purpose.  Click the 
Register button to go to the registration page on the Cybercom Software website.
The registration process is quick and easy.  You will automatically receive your
license key via email shortly afterwards.  Make sure you have an active Internet
connection.

Please note: if you ordered PhonePad directly from us or online via our website, you
do not need to register your copy of PhonePad.  This is done automatically at time
of purchase.

Click the Cancel button if you want to exit PhonePad.

http://www.cybercom-software.com/order.htm
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4.3 Licence Agreement

End User License Agreement

The following is a legal software license agreement between you, the software end user, and Cybercom Software.  Carefully
read this license agreement before using the product.  Installing and/or using the product indicates that you have read this
license agreement and agree to its terms.

Grant of License. Cybercom Software grants to you a non-exclusive, non-sublicensable, license to use this software and its
components (the "Software"), in binary executable form.  This software is NOT free.  After a once-only 60 day evaluation period
you may not continue to use it unless you have a valid license file licensed in your name or in the name of your organization.  In
the case of an Individual License, only the specified licensee may use the Software.  In the case of a Company or Site License,
the Software may only be used within the named organization.  In both cases the number of users using the software must not
exceed the licensed number of users.

Copyright. The software contained in this package is owned by Cybercom Software and is protected by Australian copyright
laws, international treaty provisions, and all other applicable national laws. The software must be treated like all other
copyrighted materials (e.g. books and musical recordings). This license does not allow the software to be rented or leased,
and the written materials accompanying the software (if any) may not be copied.

Title, ownership rights, and intellectual property rights in and to the Software shall remain the property of Cybercom Software. 
You agree to abide by the copyright law and all other applicable laws of Australia, and international copyright laws.  You
acknowledge that the Software in source code form remains a confidential trade secret of Cybercom Software and therefore you
agree not to modify the Software or attempt to decipher, decompile, disassemble or reverse engineer the Software.

Limited Warranty. Cybercom Software warrants that the software contained herein will perform substantially in
accordance with the accompanying documentation.

No Other Warranties.  Cybercom Software disclaims all other warranties, either express or implied, including but not limited
to implied warranties of merchantability and fitness for a particular purpose, with respect to the Software, the accompanying
written materials, and any accompanying hardware (if any).

No Liability for Consequential Damages.  In no event shall Cybercom Software or its suppliers be liable for any
damages whatsoever (including but not limited to damages for loss of business profits, business interruption, loss of business
information, or any other pecuniary loss) which results from an inability to use this software, even if Cybercom Software has
been advised of the possibility of such damages.  Because some states/jurisdictions do not allow the exclusion or limitation of
consequential or incidental damages, the above limitations may not apply to you.

LEGAL STUFF

The author hereby disclaims all warranties relating to this product, whether express or implied, including without limitation any
implied warranties of merchantability or fitness for a particular purpose. The author cannot and will not be liable for any
special, incidental, consequential, indirect or similar damages due to loss of data or any other reason, even if the author or
an authorized agent has been advised of the possibility of such damages. In no event shall the liability for any damages ever
exceed the price paid for the license to use software, regardless of the form and/or extent of the claim. The user of this
program bears all risk as to the quality and performance of the software.
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4.4 Ordering

Our products can be ordered online from our web site at: www.cybercom-software.com.  Please check
our web site for the latest ordering information (in PhonePad, select About from the Help menu and click
on the link).  If you have any difficulty, please contact us.

Once you have purchased a license, you will be supplied with a License Key that will change your copy
of PhonePad into a fully licensed product.  There is no need to download a different copy of PhonePad. 
The evaluation version and licensed version are one and the same.

You will be supplied with a license key file.  All you need to do is save the file to the directory PhonePad
is installed in.  If you have PhonePad installed on multiple computers you will need to install the license
key file in the PhonePad directory on each of these machines.

4.5 Problems

Unfortunately, due to the complex nature (and human nature) of many applications, bugs (undocumented
features) are a fact of life.  Although we have gone to great lengths to ensure that this product is bug-free
(if there is such a thing) some inadvertently slip through the net.  If you do come across any bugs in our
software please let us know as soon as possible.  

If you find a bug, it is important that you note any error messages that are displayed and the steps you
went through that led to the problem.  This will help us in trying to reproduce the problem.

Please report any bugs you may encounter to us (support@cybercom-software.com) and we will give
them our immediate attention.  Most problems are resolved within 2 to 4 days of them being reported.

4.6 Support

For information on Support, please see Contact Us.
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